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Legal notices 
Control4 Disclaimer 
Control4® makes no representations or warranties with respect to this publication, and specifically disclaims any express or implied 
warranties of merchantability or fitness for any particular purpose. Control4 reserves the right to make changes to any and all parts of this 
publication at any time, without any obligation to notify any person or entity of such changes. 

Legal Notice 
GNU 

GNU GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION (Section 3.b.) 

You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of 
Sections 1 and 2 above provided that you also do one of the following:  

Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically 
performing source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms 
of Sections 1 and 2 on a medium customarily used for software interchange. 

The complete text for this license is available on the Control4 web site at: http://www.control4.com.  

Gracenote 

Gracenote®, Gracenote logo and logotype, and the "Powered by Gracenote" logo are either a registered trademark or a trademark of 
Gracenote, Inc. in the United States and/or other countries. 

Music and DVD recognition technology and related data are provided by Gracenote.  

Gracenote is the industry standard in Music and DVD recognition technology and related content delivery. For more information visit 
www.gracenote.com. 

MPEG 

Fraunhofer IIS and Thomson. MPEG Layer-3 audio coding technology licensed from Fraunhofer IIS and Thomson. Supply of this product 
does not convey a license nor imply any right to distribute content created with this product in revenue-generating broadcast systems 
(terrestrial, satellite, cable, and /or other distribution channels), streaming applications (via Internet, intranets, and/or other networks), 
other content distribution systems (pay-audio or audio-on-demand applications, and the like) or on physical media (compact discs, digital 
versatile discs, semiconductor chips, hard drives, memory cards, and the like). An independent license for such use is required. For details, 
visit http://mp3licensing.com. Radio Locator is the service provider of AM/FM channel list. 

Spread 
This product uses software developed by Spread Concepts LLC for use in the Spread toolkit. For more information about Spread see 
http://www.spread.org.  

All Media Guide 
© 2005-2008 All Media Guide, LLC provides music and video recognition technology that provides cover art and related text that 
enriches the Control4 user Navigators. 

Copyright and Trademarks 
Copyright ©2015, Control4 Corporation. All rights reserved. Control4, the Control4 logo, the 4-ball logo, 4Store, 4Sight, Control My Home, 
Everyday Easy, and Mockupancy are registered trademarks or trademarks of Control4 Corporation in the United States and/or other 
countries. All other names and brands may be claimed as the property of their respective owners. All specifications subject to change 
without notice. 
No part of this publication may be reproduced, photocopied, stored on a retrieval system, or transmitted without the express written 
consent of the publisher.  

Contact Information 
Control4 Corporation 
11734 S. Election Road 
Salt Lake City, UT 84020 USA 
http://www.control4.com 

Part number: 200-00170-P 
Composer Home Edition User Guide (OS 2.8.0, 10/14/2015 DH) 
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Introduction 
This document gives you comprehensive information, tips, best practices, and 
examples about how to use Composer Home Edition (HE) for Control4 Operating 
System (OS) Release 2.8.0 (OS 2.8.0). Use Composer Home Edition (Composer HE) 
Monitoring, Media, Agents and Programming views to modify your system.  

The purpose of this document is to give you instructions and examples about how to 
use the Composer HE application to monitor your system, set up your media, program 
the system, use agents, and other useful Composer HE tasks. 

Getting started  
For basic startup information, refer to the Composer HE Getting Started help in the 
Composer HE application (located in the menu bar) or in PDF format on the Control4 
website). The guide also contains information on installation, setup, and getting 
familiar with the Composer HE interface. 

Related documents and resources 
You can find the following related documents in PDF (in some instances, web help) 
format here: http://www.control4.com/customers/resources#documents. 

• Composer Home Edition Getting Started (200-00169) 
• Control4 System Quick Start Guide (200-00153) 
•  
• Control4 System Remote Control SR-250 User Guide (200-00152) 
• Composer Media Edition User Guide (200-00171) 
• TuneIn User Guide (DOC-00082) and TuneIn Quick Setup Guide (DOC-00079) 
• Instructional videos 

Monitoring the system 
Note: This section assumes you are familiar with the Composer HE interface. If you are 
not, see Composer HE Getting Started. 

The Control4 Composer HE Monitoring view is designed to help you view your 
system, rooms, and devices. To access the Monitoring view, start Composer HE. When 
you choose the Monitoring view (highlighted in the lower left pane), you have two 
tabs to choose from: List View and Properties. 
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Monitoring view: 

 

Check the Device Status in List View 

The default page in the Monitoring view is 'List View' (first tab, top right) which lets 
you view all the devices in your Control4 system and their current state.  

List View groups devices under the rooms to which they're assigned. In the example 
above, all of the devices are located in the Living Room because the Living Room is 
selected in the project tree (Monitoring pane). 

• Monitor Status 

You can monitor the status of devices in the system. In List View, double-click on 
the device's icon to bring up the device's controls. Light levels are indicated with 
slider bars and buttons for on or off state. Each device has a different set of 
controls. 

• Device Controls 

You can access the device's controls by double-clicking on any device icon in 
either the project tree or the List View tab. 
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Try this:  

Double-click on any device with an On/Off option to access the device's controls, for 
example, a switch. Turn the device on or off; some devices have a color change on the icon 
in the Device Control and in the List View. See also “Checking the Device Status.” 

Change Project Properties 

The main Composer HE view shows the Properties pane. Click the Properties tab to 
view the properties of the project, room, or device. 

 

The Properties pane displays the following elements: 

• Project Properties. This lets you change general information about the project 
according to the location of the Control4 system. In the project tree, click the 
project name (BN Office is the example above).  

Use the Project Properties pane to do the following: 

• Change the name of the project  
• Change/enter the ZIP Code of the location where the Control4 system 

resides 
• Change the date and time 
• Change the project settings 
• Enable SSL and password for security purposes 
• Change localization options 

• Room Properties. In the project tree, click a room to view its Properties. 

This lets you edit Room Properties in the following tabs: 

• Audio Video Devices. Shows your available audio and video devices, where 
your audio and video end points are, and what is controlling the volume. If a 
device does not appear in this window and you think it should, check the 
connections. The connections may not be mapped properly. 

• Navigator. Lets you hide/re-order the device's visibility and display order in 
a room, including lighting scenes. 
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• Miscellaneous. Lets you enable the default audio or video volume for a room, 
and assign an IP mask to the room for programming a third-party remote. 

• Device Properties. Click on a device from the project tree to see its editable 
properties. For example, you can set the one-click ramp up and ramp down rates 
on a Wireless Dimmer. You can also edit the LED colors for all of your switches, 
keypads, and dimmers.  

Control4 recommends that you look over the properties of each device to see how 
you can change them. 

See also “Checking the Device Status” (next) or “Changing project properties” later in 
this document. 

Checking the device status 
Use the Control4 Composer HE Monitoring view to check the status of the devices in 
your system by room. 

Prerequisites 

Ensure that the devices you want in your system have been added and identified to 
the system. Check with your Control4 Dealer or installer to add devices. 

To check device status: 

1 Start Composer HE and connect to a Director. 
2 In the project tree, select a room. The devices are categorized by the room in 

which the device is installed. 
3 Click the List View tab. 
4 Double-click a device to bring up its configuration and controls. 
5 Check or change the configuration as needed. 

Changing project properties 
Use the Control4 Composer HE Monitoring view to check and change the properties 
of your project. You can change device and room properties also, but they aren't 
discussed in this section. 

To change the properties: 

6 Start Composer HE and connect to a Director. 
7 Click the Properties tab. 
8 Change the boxes as needed: 

• Name. Enter the project name. 
• Location. Click Lookup to change the Latitude and Longitude based on the 

location of the system by entering the city, state, or ZIP Code. 
• Date & Time. Use the drop-down lists to select the date and time. Click edit 

to change the time zone. 
• Project Settings Control. Check Push Settings From Project to set a device 

in Composer HE not to allow anyone to change the setting at the device. 
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• System Security. If set, all Navigators must connect through a secure 
connection. Secure Connections Only (SSL)—Check this box if you want all 
Navigators in this system to go through a secure connection. Click Change 
Password to change this password. 

• Localization. Lets you set the locale and character set for countries outside 
the Unites States. 
• Locale—Use the down arrow to change the locale. 
• Encoding—Use the down arrow to select the character set. 
• Add Locale—Click to locate the PO files to convert and the Locale Code. 

Click OK. 

Setting up your media and playlists 
To take full advantage of media lookup services by Gracenote, you must be registered 
in 4Sight. 

After you have completed the initial setup of Control4 Composer HE (see Composer 
HE Getting Started), you can set up and modify the media in your system. 

To add and scan songs and albums for playlists, they must be available in MP3, WMA, 
MP4, M4A/AAC, or FLAC format on a PC or network share. 

To add Internet radio stations, the Internet radio driver must be connected to the 
controller. See your dealer for details. 

Other Media Managers: You can use other media managers, for example, iTunes, 
Windows Media player, and Media Monkey to create MP3s, WMAs, or MP4s. You can 
still use Composer ME and Composer HE to add files to Control4. 

To view and select the media from the Navigators—the on-screen, touch screens, 
Control4 apps, or System Remote Control (to select media on-screen)—you first need 
to add and scan the media into the media database which resides in Director on the 
primary controller. Use the Media view to perform these activities. 
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Media view 
From this view you can see the media in your project, add or scan your media, 
manage changes to your media, and manage playlists. 

Media view (same view as the main screen after startup): 

 

There are four main categories listed in the Media window (left pane): 

• Media Scanning Options 
• Stored media 
• Broadcast media 
• Playlists 

Media Scanning Options 
Media Scanning Options lets you view the storage space status for your media 
information and configure media scanning options. 

Stored media 
Stored media refers to media physically or digitally stored in the Control4 system. 

Media types supported: 

• CD and DVD discs, or Disc Changers—Store DVD and CD disc information 
including high-resolution Cover Art, Title, Artist(s), Genre, and more. 

• Digital media—Store digital audio (AIFF, FLAC, MP3, M4A, OGG, WAV, and WMA 
file types) and digital video (AVI, DVD, DIVX, ISO, MKV, MPG, MP4, MOV, and 
WMV file types) media information including high-resolution Cover Art, Title, 
Artist(s), Genre  and more. Digital media files can be stored on a controller with a 
hard drive (for example, an HC-1000), on USB or eSATA drives attached to a 
controller, or on a Network File Storage location.  
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Broadcast media 
Broadcast media refers to radio stations (AM/FM and XM/Sirius) and TV stations 
(over the air, satellite and cable). 

Media types supported: 

• Satellite TV—Store satellite TV (DirecTV, Dish, and others) channel information 
including high-resolution channel logo, channel number, description, and genre. 

• Cable TV—Store cable TV channel information including high-resolution channel 
logo, channel number, description, and genre. 

• UHF/VHF—Store UHF/VHF (over-the-air TV) channel information including high-
resolution channel logo, channel number, description, and genre. 

• AM/FM/XM—Store AM, FM, and XM radio station information including high-
resolution station logo, station number, description, and genre. 

Playlists 
With Composer HE and Composer ME, you can create and manage playlists created 
from your digital media files. See “Setting up playlists” in this document. 

Adding digital media files to your Control4 system 
Before you can view and select your media from the Control4 Navigators, your media 
must be added into your system. Composer HE can assist you in adding digital media 
files to a desired storage location, on a Network File Storage or USB/eSATA drive 
connected to your controller. Your Control4 system can scan the media files to import 
existing metadata, if present in the media files, and perform an online search to find 
relevant media information. So you first need to add and scan your media using the 
Composer HE Media view.  

 

Prerequisites 
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Before you can add digital media files to a storage location, the storage location must 
be configured and accessible to your Control4 system. Ensure that the appropriate 
devices have been added to your Control4 system and are connected to the network 
or the controller. Contact your dealer or installer for details. 

To add and scan digital audio media files: 

1 In the Media list on the left, select the storage location. If the storage device is a 
Network File Storage, select Audio Media. 

2 In the right pane, click Add.  

Tip: If you get a dialog box that states you cannot add media, contact your dealer 
or installer to configure the storage location. 

3 Browse to the folder that contains the files that you want to add. Select the folder 
and click OK. 

Composer ME will copy the media files to the storage location. After the files have 
been added, the scan automatically starts. In a few moments, the media is 
scanned and you will see a list of albums appear. You might see the on-screen 
Navigator update during this process also. 

Tip: Another way to add files to a network share is to go to the Windows Start 
menu, and select Run. Type \\<network share’s IP Address>\, press Enter, 
navigate to the desired folder, and copy the files. After copying files directly to 
your storage location, you need to start a scan manually. See “Auto-scan media in 
Composer ME” 

4 Refresh your Navigators. 
5 The media is now selectable for viewing from the touch screens, Control4 apps, 

on-screen Navigators, and System Remote Control. 

To add and scan digital video media files: 

1 You must add digital video media files to your storage location manually. You can 
copy them to your eSATA drive, if connected to your computer, or copy them to 
your network storage location. To add files to a network share, go to the Windows 
Start menu, and select Run. Type \\<network share’s IP Address>\, press Enter, 
navigate to the desired folder, and copy the files. 

2 In the Media list on the left, select the storage location, and select Video Media. 
3 In the right pane, click Scan. See “Scanning media in Composer ME” for more 

details. 

Composer ME will scan the digital video files from the selected storage location. 
In a few moments, the media is scanned and you will see a list of videos appear. 
You might see the on-screen Navigator update during this process also. 

Tip: To play back digital video files, a media player capable of playing those files 
and communicating with your Control4 system must be added to the project. 
Contact your dealer for more information.  

4 Refresh your Navigators. 
5 The media is now selectable for viewing from the touch screens, Control4 apps, 

on-screen Navigators, and System Remote Control. 
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Setting up media on a disc changer 
When setting up a Control4 disc changer to play music or movies, you can add and 
scan media in Composer HE according to the options available on your disc changer. 
Adding and scanning populates the media information to the media database, which 
lets you view the media from your Navigators. 

 

In the Media pane, when you highlight Disc Changer, if the options are available on 
your disc changer, you will see following active buttons: 

• Scan—Lets you add and scan media located on your disc changer, and add it to 
the media database (recommended if available). 

• Search—Lets you search for media titles located on your disc changer, and add 
them to the media database. 

• New DVD or New CD—Lets you add new DVDs and CDs to the media database. 
• Edit—Lets you edit by Type, Title, Artist, Genre, etc. 
• Delete—Lets you delete an entry. 

 

The following sections demonstrate how to add a disc changer to the media 
database with these options. 

Prerequisite 

Ensure that the disc changer driver has been added to the project and identified. 
Check with your dealer or installer to do this for you. 

To scan media on the disc changer to the media database: 

1 In the Media view, select Disc Changer in the Media pane.  
2 In the disc changer pane, click Scan. The scan results appear. 
3 Refresh the Navigators. You are ready to play music now. 

To search media on the disc changer and add it to the media database: 

1 Select the Disc Changer in the Media pane. 
2 In the Disc Changer pane, click Search. The Search dialog appears. 
3 Type the DVD name in the blank box, for example, type ‘A Beautiful Mind’ and 

click Search. The possible DVD title matches from the web database appear in 
the Search Results window.  

4 Use the scrollbar if necessary to find the appropriate DVD title.  
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5 Highlight the appropriate DVD title, drag it directly over the empty line item, and 
select it. 

 

6 Click Finished. 
7 Repeat these steps for the DVDs/CDs in the disc changer that you want to add to 

the media database. 
8 Refresh your Navigators. The media you added is now selectable for viewing in 

the Navigators. 

To add and search using the New DVD or New CD options: 

1 In the Media view, select Disc Changer in the Media pane.  
2 Click in the empty box for the New DVD and New CD buttons to appear.  
3 Click either New DVD or New CD as appropriate. The New Movie or New Album 

dialog appears. 
4 In the Title box, enter the DVD you want to play, for example, 'A Beautiful Mind.' 
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5 Click Search. 

 

6 When the Search dialog appears, use the scrollbar if necessary to find the 
appropriate cover art, and then select it. 

7 (Optional) You can change the search criteria and search again if necessary. The 
possible matches from the web database appear in the Search Results window. 

8 Click Next. You can choose which information to import, and then edit any 
associated information before adding it to the media database. 

9 Click Finished. 
10 Click OK. 
11 Refresh your Navigators. This particular DVD is now selectable for viewing in the 

Navigators. 

Note: Use these steps for new CDs also. Similar results occur. 

Setting up media auto-scan  
Your Control4 Dealer or installer can use the auto-scan feature in Composer Pro to 
scan your media automatically.  

Notes:  
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• If you scan a DVD or CD, and the media is not recognized, it will be titled 
“unknown.” You can edit the DVD or CD's metadata and manually provide this 
information from Composer ME. 

• Because media scanning has been moved to the background, the scanning status 
is only available through Director status messages. To do this, you can either 
watch the Director status line or re-select the media to view the content that has 
been scanned. 

Prerequisites 

Ensure that the devices you want to scan have been added and identified in the 
Control4 system. Your dealer or installer can do this for you. 

To schedule a regular scan of media: 

1 From the Composer ME main screen, select Media Scanning Options. To scan 
your media now (and not set up a scheduled scan), click Scan Now and skip the 
Scanning Schedule in Step 2. 

2 In the Options pane, set the schedule as follows: 

• Scanning Schedule—Select one: 
• Never—Select if you never want to schedule an automatic scan. 
• Every x Days or Weeks (up to 10)—Select the frequency to scan. 
• On the following days—Select Sunday through Saturday. 
• At <time>—Use the up and down arrows to select the time. Highlight AM 

or PM and type the value: AM or PM. 
• Files To Scan. Select a device and extension. 

• Network File Storage—Select if you have a NAS (network attached 
storage) device you want to scan. 

• USB Drive—The manufacturer's USB drive appears here. Select if you 
have a USB drive you want to scan. 

• Extensions—Use the up and down arrows to choose the file type to add 
or remove. To add a file extension (if it doesn't appear in the list), use the 
down arrow to select the extension, select Video or Audio, and then click 
Add. Click Remove to remove that file type from the list. 

• Use Online Media Lookup to improve scan results—Check if you  want 
the scan to access the Internet to search for missing metadata 
information (title, cover art, genre, tracks, or other information.). Tip: To 
update existing media with high-resolution cover art after updating your 
system to OS 2.8+, check this box and scan the media files. 

• Remove media from the database if the files no longer exist—Check to 
remove database information when a media file has been deleted. 

Important: If you disconnect a USB drive with media on it and run a scan 
with this option selected, the media database entries will be deleted, and 
you may not want to delete them if you use the drive again. 

• Update media database if file tags have changed—Check to have the 
database updated if the metadata changes. 

3 Click Apply. 
4 Click Scan Now to start the scan immediately or Stop Scan if you've started the 

scan and want to stop it. 
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Setting up media for TV channels 
Use the Media view to set up your local broadcast channel stations and listings for 
display in the Navigators. 

Prerequisites 

Ensure that the broadcast media has been added and identified to the Control4 
system. Check with your dealer or installer who can do this for you. 

To set up media for broadcast TV channels: 

1 In the Media view, click UHF/VHF or another broadcast media type. 
2 Click Search. 
3 When the dialog appears, type your ZIP Code in the box. 
4 Click Search and use the pull-down menu to select NTSC (analog) Broadcast. 

The available channels are populated to the Search Results. 

Note: This feature is only available in the United States. 

5 Click the boxes to select the desired channels that you want to appear on the 
Navigators. 

6 Click OK. 

 

The selected stations populate in the UHF/VHF pane. You can edit the 
information as needed; add a description, genre, etc. 
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7 (Optional) To edit a channel, select the channel, and click Edit. 
8 Edit the information and click OK. 
9 Refresh your Navigators. You can now view and select the media from the 

Navigators. 

Setting up media for radio stations 
Use the Media view to set up your media for radio broadcast stations. 

Prerequisites 

Ensure that the broadcast media has been added and identified to the Control4 
system and that you have a tuner installed in the system. Check with your dealer or 
installer who can do this for you. 

To set up media for broadcast radio stations: 

1 In the Media view, click AM Radio or FM Radio. 
2 Click Search.  
3 When the dialog appears, type your ZIP Code in the box. 
4 Click Search again. Use the pull-down menu to select AM Broadcast Stations or 

FM Broadcast Stations. The available stations are populated to the Search 
Results window. 

5 Click the boxes to select desired stations that you want to appear on the 
Navigators. 

6 Click OK.  
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The selected stations populate in the AM or FM Radio pane.  

7 (Optional) To edit a station, select the station, and then click Edit. 
8 Edit the information, and then click OK. 
9 Refresh your Navigators. 
10 Repeat the previous steps for each radio you want to set up. Set up each one 

separately. The media is now ready to view and select from the Navigators. 

Setting up an Internet radio station 
Use the Media view to add Internet radio stations that you can play from touch 
screens, Control4 apps, or on-screen Navigators. A better alternative to this might be 
to use TuneIn. See the TuneIn Setup or TuneIn User Guide for details. 

Prerequisites 

• Ensure that the controller is installed and identified as directed in the controller's 
installation guide. 

• Ensure that the Internet radio stations you add are in MP3, WMA, or MP4 format. 
You'll need to create a new form for each station you add. 

To configure Internet radio: 

1 Start Composer HE and connect to a Director. 
2 Click the Media view. 
3 From the Media list, click Internet Radio. 
4 In the Internet Radio pane, click New. 
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5 Fill out the form: 
a Name: Add the name of the station. 
b Description: Add a description that's meaningful. 
c Channel: Add the URL for the channel. Note: Locate the URL of the MP3, 

WMA, or MP4 stream that starts with http://... Instructions about how to do 
that are outside the scope of this document, but your dealer should be able to 
help you set some up for you. 

d Genre: Add a genre if appropriate. 
e Check Audio Only for listening. 
f Cover Art: If you'd like, you can copy the radio station art to your list. In a 

browser, go to the link and click Images. Click Find Art File to locate an 
image, copy it to your clipboard and then click Paste from Clipboard. 

g Click OK. 
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6 Go to a touch screen, Control4 app, or on-screen Navigator and select the Listen 
> Station. Note: If you have several sources, Internet Radio appears under 
Sources. 

Using TuneIn 
An alternative to setting up an Internet radio station would be to use TuneIn. Create a 
TuneIn account and pair your TuneIn account to the Control4 system, so you can play 
your favorite stations on your Control4 Navigators. For more information, see the 
TuneIn Setup or TuneIn User Guide. 

Testing the media information 
To test control of media through the Control4 Navigators (System Remote Control, 
on-screen Navigator on your TVs, LCD Navigator, Control4 app, or any of the other 
navigators or touch screens), use the steps outlined in the Control4 System User 
Guide. 

Suggested test items: 

• Playing an album 
• Adding an album or track to the Now Playing queue 
• Playing a playlist created in Composer 
• Creating a playlist at a Navigator (for example, one of the touch screens) 
• Playing multiple streams of music (play different music in different rooms) 
• Playing a movie on the television 

 

Creating a playlist 
Use the Media view to set up a playlist to play songs and albums from your touch 
screens, On-Screen Navigators, or System Remote Control. 
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Note: To set up a playlist for TuneIn or another Internet music service, check with your 
dealer or installer or refer to the provider’s documentation. 

Prerequisite 

Ensure that you have scanned your media from your media storage device to the 
digital audio player on the controller. 

To create a playlist: 

1 From the Media menu, select New Playlist. 

 

2 'New playlist' appears that you can rename immediately, or later you can right-
click and select Edit to change the name. Example: Change ‘New’ to Frank’s 
Playlist. 

The playlists are designed exclusively for streaming media in digital audio. 
Playlists are not intended to include broadcast channels or stations. 

3 Select the storage device. 
4 Drag and drop any albums or songs you want to add to the playlist. 
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5 (Optional) To delete unwanted songs after you've added the albums, highlight the 
playlist by right-clicking the song and selecting Delete. 

Tip: To remove individual songs, right-click Delete. To remove multiple songs, 
press Shift, highlight the items to remove, and then right-click Delete. 

6 Edit and play your playlists using the Navigators. 

Tip: You can create new playlists from your touch screens or on-screen Navigator 
also. See the Control4 System User Guide for details. 

Editing media information 
Use the Media view to edit your media information for 'unknown' DVDs or CDs. You 
can edit media information also in the Navigators. 

Prerequisite 

Ensure that the appropriate media devices and media have been added and identified 
to the Control4 system. Your dealer or installer can help you do this. 

To edit CD information: 

1 In the Media view, double-click the device for which you want to edit the media, 
for example, CD, Disc Changer, Digital Audio, etc. 

2 Click Edit or double-click the album in the Album Title column. The album's 
dialog box appears. 

 

3 To edit and enter any changes, click the Album tab.  
4 Click the boxes under Name, Artist, Label or Genre. In the Tracks and Notes tabs, 

view and edit Track Titles and Notes.  
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5 Click Search next to Name or Artist to search the database for similar entries. 

 

6 To add artwork, click Find Art File. 
7 To remove the album cover art, click Remove Art. 
8 When you are finished, click OK. 
9 To select a search result, select the album title, and click Next. 
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10 View and edit the information for the album, including Name, Artist/Composer, 
Label, Genre, Year, Art, and Notes. 

 

11 Make changes as desired. Click Back to return to previous screens. 
12 Click Finished. 

To edit DVD information: 

1 In the Media view, select the movie under Disc Changer or DVD. 
2 Click Edit or double-click the title under Discs. 

 

3 Click the Movie tab. Edit the Title, Director, Studio, Genre, Run Time, Release 
date and Rating as desired.  
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4 Click the Cast and Synopsis tab. Click the Cast and Synopsis boxes, and make 
the desired changes. 

 

5 Click Search in the Movie tab to search the database for other DVDs. 
6 Double-click the desired DVD and edit as desired according to the previous steps. 
7 When you are finished, click Finished. 

Programming the system 
Use the Programming view to program your Control4 system. 

Programming basics 
Use the Programming view to configure events and actions. In Composer HE, click 
Programming to display the Programming view. 

Configuring is based on events. When an event starts, it triggers actions to take place.  

Example: When the projector screen lowers (the ‘event’ starts), the receiver, DVD 
player, and projector all power on (the ‘actions’ of the receiver, DVD player, and 
project are all caused by the screen-lowering event). 
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To program the Control4 system, you use Composer HE to drag-and-drop events and 
actions for corresponding devices to a Script pane. Details about how to do this are 
explained below. 

This table describes the events, actions and scripts used when configuring the system, 
and how they are used. 

Item Description 

Events All programming begins with events. An event is a “when” statement: the 
trigger reporting that something happened, resulting in an automated 
action. Events happen instantaneously.  
Example: On a keypad, pushing a button is one event. Actions all happen 
under events.  
Other events include:  
When the door opens 
When it is 7:00 a.m. 
When it is sunrise 

Actions After the event communicates to the system that something happened, it 
will send actions.  
These methods are used to define actions: 
Commands. The Commands tab displays all available commands for a 
selected item in the Device Actions tree. A command is a “do” statement. 
Commands are actions the Director tells the device to do so it performs a 
certain behavior.  
Examples of commands include: 
Light: on, off 
VCR: play, stop, pause 
CD Changer: go to disk 
Security device: arm, disarm 
TV: Power on/off, change channel 
Conditionals. The Conditionals tab displays all available conditionals for a 
selected item in the Device Actions tree. A conditional is an “if” statement. 
An “if” statement asks a true/false question to the device.  
Examples of conditionals include: 
If door is open 
If after 5 p.m. 
If the light is greater than 50 percent 
Delays. A Delay stalls a program from running to ensure that the actions 
happen at the right time. 

Script The linking of events and actions is defined in the script. These events and 
actions get moved into the Script pane. 

Tip: You can use properties, agents and variables also to configure or program 
devices. These are considered advanced configuration and programming. See 
“Programming with agents” in this document for information. 

Basic programming consists of two parts: 

1 Define a device’s events that trigger the actions (left pane). 
2 Define a device’s actions to trigger when an event fires (right pane). 

Refer to the steps in the next two figures to learn about basic Control4 system 
programming tasks. 
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3 Define the device's events (follow the screen’s steps and arrows below): 

 

4 Define the device's actions (follow the screen’s steps and arrows below): 

 

Note: Programming makes use of agents also, which let you include pre-
programmed system functionality, for example, scheduling, delays, or setting up 
lighting scenes.  

Example: To program around sunrise and sunset, you use the Scheduler agent. 
See “Programming with agents” for information about using agents in 
programming. 
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Programming with commands 
Use the Programming view to configure Commands. 

A Command is a “do” statement. Commands are actions that tell a specific device 
what to do. 

Example: The steps below show how to configure a 3-Button Keypad to turn on the 
sprinklers using a relay for control. 

Prerequisites 

In this example, ensure that the devices you want to configure (controller, 3 Button 
Keypad and Sprinklers Relay) are added and identified to the system. Your dealer or 
installer can help you do this. 

The following example uses these devices in the project: 

• Controller 
• 3 Button Keypad 
• Sprinklers 

To program a 3-Button Keypad to toggle sprinklers on and off: 

1 In Composer HE, click Programming.  
2 From the project tree, click 3 Button Keypad. 
3 Click the button that you want to program—Button 1 (selected by default). 

This automatically identifies the 'Press' event for programming. The event appears 
at the top of the Script pane (center pane). 

 

4 From the Actions pane (right pane), highlight Sprinkler System.  
5 Click the Commands tab, and select Toggle the Sprinkler System. The command 

you chose (Toggle the Sprinklers) displays in the right middle pane. This is an 
action. 
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6 Click the green arrow, and drag it to the Script pane (center pane). 

 

7 In the Script pane, click Execute to turn on the sprinklers.  
8 Click Execute again to turn off the sprinklers. 
9 Now press the top button on your 3-Button Keypad to toggle the sprinklers on 

and off. 

Programming with Delay, Stop, and Break Commands 
Use the Programming view to program using Delay, Stop and Break Commands. 

Delay provides a delay command in response to an event that waits for a specified 
period of time before executing the next command in a code item. 

When configuring a device, you always have the following options: 

• Delay—Lets you delay an action that is taking place. 
• Stop—Lets you stop all programming. 
• Break—Lets you break out of a conditional loop when a specified condition is met 

and return to programming outside of the loop. Note: Usually, the Break 
command is available only in Composer Pro (the application your dealer uses), 
but it might be present in the programming set up for your project. 

Prerequisite 

Ensure that the devices you want to program are added and identified to the system. 
Your dealer or installer can help you do this. 

To use Delay, Stop, and Break commands during programming: 

1 In Composer HE, click Programming. 
2 Select a device and an event. 

30 



Composer HE 2.8.0 User Guide  Programming the system 

3 To use the Delay, Stop, or Break commands, from the right-side pane select the 
Programming Control object (scroll down to bottom of the project tree to find 
it). 

4 Click the Commands tab, select Delay, and select the number of seconds (for 
example, 5 seconds). The delay appears on the left side, middle pane. 

5 Drag and drop the delay command to the Script pane.  

Example: This will ensure that there is a 5-second delay after the projector powers 
on. 

 

Programming with conditionals 
Use the Programming view to program using conditionals. 

A conditional is an “if” statement that asks a true or false question to the device. 

Example: The steps below show how to use conditionals in programming. In this 
example, “when” a doorbell is pressed and the light is off, program the light to turn on. 

Prerequisite 

In this example, ensure that the devices you want to program (controller, doorbell and 
switch) are added and configured in the system. Your dealer or installer can help you 
do this. 

The following example uses these devices in the project: 

• Controller 
• Doorbell 
• Theater Switch 

To program a conditional that turns on the light when the doorbell is pressed if the 
light is off: 

1 In Composer HE, click Programming.  
2 From the project tree, highlight Doorbell in a room. 
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3 Select the When the Doorbell is pressed event.  

The event appears at the top of the Script pane (center pane). 

 

4 From the Actions pane (right pane), click Light Switch. 
5 Click the Conditionals tab, and select Is Off. The system displays the conditional 

you chose in the right middle pane.  
6 Click the blue question mark, and drag it to the Script pane. 

 

7 From the Actions pane, click Light Switch again. 
8 In the Commands tab, select On. The command you chose displays in the right 

middle pane.  
9 Drag the green arrow directly on top of the blue question mark in the Script 

pane to make it a child under the When the Doorbell is pressed statement. 
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Tip: If you drag the action to the text, or you drag the action under the text into the 
open space, it places the action as an equal above the conditional. If you drag the 
action to the question mark, it becomes a child under the conditional. Watch the arrow 
to see in which direction it points to place the action as a peer or a child below the 
statement. 

 

10 Go to your Theater Switch, and ensure that the light is off.  
11 Press your doorbell button, and the light turns on. 

Using room variables 
Control4 room variables provide greater flexibility in programming, letting you 
program using events and actions at the room level. 

Note: Most of the functions in room variables are available by selecting the Room 
object. The Room object is the recommended method for configuring the room. 
Whenever possible, use the Room object rather than room variables. 

To use room variables: 

1 Start Composer HE and connect to a Director. 
2 Click Programming. In this view listed under every room in the project tree is a 

Room Variables object. 
3 Click to expand the Room Variables options. Room variables are available as 

events and actions. 
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Room Variables: 

 

The room variables are described in the following table. 

Events/Actions Description 

CURRENT_SELECTED_DEVICE Lets you do programming when any device changes in 
the room. 

CURRENT_MEDIA Lets you do programming when any media changes in the 
room. 

POWER_STATE 
Lets you do programming when any device’s power state 
changes from True to False in the room (read only). A 
device in the room is required to detect the power state. 

CURRENT_VOLUME 
Lets you do programming when the volume of the 
currently-selected audio path changes in the room 
(requires discrete volume). Use conditional programming. 

HAS DISCRETE_VOLUME 
Lets you do programming when any devices change in 
the room (requires discrete volume). Use command 
programming. 

HAS_DISCRETE_MUTE Lets you do programming when the Mute state is known 
(MUTE_ON or MUTE_OFF). 

IS_MUTED Lets you do programming when in Mute state 
(MUTE_ON). 

IN_NAVIGATION Lets you do programming when On-screen is available. 
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Events/Actions Description 

USE_DEFAULT_VOLUMES 

Lets you do programming any time a selection changes 
to reset the default volume. For example, when changing 
from viewing a DVD to listening to music, the volume is 
reset to the default discrete set volume. 

DEFAULT_AUDIO_VOLUME Lets you program the default Audio volume. 

DEFAULT_VIDEO_VOLUME Lets you program the default Video Audio volume. 

VOLUME_IS_LINKED Lets you set programming not to affect already linked 
volume. 

MUTE_IS_LINKED Lets you set programming not to affect already linked 
mute state. 

ROOMOFF_IS_LINKED Lets you set programming not to affect already linked 
room off state. 

SELECTIONS_LINKED Lets you set programming not to affect already linked 
selections. 

ROOM_HIDDEN Lets you set programming to hide rooms from appearing 
on the navigation device. 

MEDIA_SCENE_ACTIVE Lets you set programming to set a media scene as active. 

Variable handling 

In programming, variables are easier to define than conditional loops. 

Note: It is important to type the variable names precisely. A typographical error 
causes the program to fail. 

Variable-handling enhancements: 

• Preserve user-defined variables—Preserves the user-defined variable values (for 
example, the current dimmer’s light level) across a normal system restart. It may 
not preserve them if the system shuts down abnormally. 

• Program a system startup event—Initializes variables or performs other 
programming at system startup with a system startup event (in Programming, 
select the root of the project, and then select the event When the project is 
loaded). 

• Define one variable to equal another—Defines one variable to equal another 
variable. Use this option to save and restore variable values. 

Example: The level of a light or the volume of music in a room. 

After this value is saved to the variable, you can restore the system variable to the 
value stored in the user variable. The system can then compare the two variables 
and determine if it needs to reset one of them. 

• Create the event “When a System reboots”—Sends an email notification to your 
dealer that your system rebooted, helping your dealer monitor the system’s 
performance. 
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Using custom variables— Boolean 
Use the Programming and Agent views to create and program with custom variables 
that have a Boolean (true/false) value. 

In this example, when someone is at the door: 

• Program to activate the Media Scene, 'Someone is at the door,' and turn on the 
porch light. 

• Program to play a song in the Bedroom and the Theater. 
• When the Motion Sensor stops sensing motion at the door, program to turn the 

music and porch light off. 

Prerequisites 

Ensure that the following devices are added and identified in the project. Your dealer 
or installer can set these up for you. 

This example uses the following devices in the project: 

• Controller 
• Porch Light Switch 
• Bedroom music 
• Theater music 
• Motion Sensor 

Create a new variable—Boolean 

To create a Boolean variable: 

1 In Composer HE, click Agents. 
2 Select Variable. The Variables view appears. 
3 Click New. 
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4 On the dialog that appears, do the following:  
a Click New Variable. 
b In the drop-down menu, select Boolean. 
c Name the variable Power State, and then click OK. The default value is false. 

 

Create a media scene “Someone is at the door” 

5 Select the Media Scenes agent, and click New. 
6 Name the Media Scene Someone is at the door. Click OK. 
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Add the rooms 

7 Click Add Room, and add the Family Room and Kitchen. 

 

8 Set the volume in the Family Room to 50, and the volume in the Kitchen to 75. 

 

9 Click Programming to display the Programming view. 
10 In the project tree and the Device Events pane, click to expand Variables, and 

then select Power State. 
11 In the project tree and in the Device Actions pane, click to expand Variables, and 

then select Power State. 

Add the Conditionals and Commands 

12 Click the Conditionals tab. 
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13 In the Conditionals tab, click Is False, and then drag the blue question mark to 
the Script pane. 

 

14 Click the Commands tab. 
15 In the Commands tab, click Set to True, and then drag the green arrow on top of 

the blue question mark in the Script pane to make it the first subset item of the 
first conditional. 

16 In the Device Actions pane, select Light Switch. 
17 Click the Commands tab. 
18 In the Commands tab, click On, and then drag the green arrow on top of the blue 

question mark in the Script pane to make it the second subset item of the first 
conditional. 
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19 In the project tree and in the Device Actions pane, select Media Scenes. 
20 Click the Commands tab. 
21 Click Activate in the Commands tab, and then drag the green arrow on top of 

the blue question mark in the Script pane to make it third subset item of the first 
conditional. 

22 In the project tree and in the Device Actions pane under Variables, select Power 
State. 

23 Click the Conditionals tab. 
24 In the Conditionals tab, click Is True, and then drag the blue question mark to the 

Script pane (this is the second conditional). 
25 Click the Commands tab. 
26 In the Commands tab, click Set to False, and then drag the green arrow on top 

of the blue question mark in the Script pane to make it the first subset item of 
the second conditional. 

27 In the project tree and in the Device Actions pane, select Light Switch. 
28 Click the Commands tab. 
29 In the Commands tab, click Off, and then drag the green arrow on top of the blue 

question mark in the Script pane to make it the second subset item of the second 
conditional. 

30 In the project tree and in the Device Actions pane, select Media Scenes. 
31 In the Commands tab, click Deactivate, and then drag the green arrow on top of 

the blue question mark in the Script pane to make it the third subset item of the 
second conditional. 

 

32 In the project tree and in the Device Events pane, select Media Scenes and then 
choose the event Someone is at the Door. 

33 In the project tree and in the Device Actions pane, select the Family Room object. 
(Repeat the next four steps for the Kitchen also.) Note: Bedroom and Theater are 
shown in the next figure. 

34 Click the Commands tab. 
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35 In the Commands tab, click Select Media. 

 

36 In the dialogue that appears, select the album and song that you want to play 
when Someone is at the Door executes, for example, ‘Knock Three Times' by 
Lynn Anderson (or in the example Mom’s Playlist). Click OK. 

37 Drag the green arrow to the Script pane. 
38 Repeat Steps 33-37 for another room. 
39 In the project tree and in the Device Events pane, select Motion Sensor under 

Front, and then choose the event When the Motion Sensor senses motion. 

Add the Boolean values 

40 In the project tree and in the Device Actions pane, click to expand Variables, and 
then select Power State. 

41 In the Conditionals tab, click Is False, and then drag the blue question mark to 
the Script pane (this is the third conditional). 

42 In the Commands tab, click Set to True, and then drag the green arrow on top of 
the blue question mark to make it the first subset of the third conditional. 

43 In the project tree and in the Device Events pane, choose the event When the 
Motion Sensor stops sensing motion. 

44 In the project tree and in the Device Actions pane, click to expand Variables, and 
then select Power State. 

45 In the Conditionals tab, click Is True, and then drag the blue question mark to the 
Script pane. 

46 In the Commands tab, click Set to False, and then drag the green arrow on top 
of the blue question mark to make it the second subset of the third conditional. 

Results: The Porch Light turns on and plays a song in the Family Room and 
Kitchen (or the rooms you selected) whenever the Motion Sensor senses motion 
at the front door. 
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Using custom variables—Number 
Use the Programming and Agent views to create and program with custom variables 
that have a numeric value. 

In this example, program one keypad button to toggle between turning on the 
Theater Dimmer and the Theater Switch. 

Prerequisite 

Ensure that the correct devices are added and identified in the project. Your dealer or 
installer can do this for you. 

This example uses the following devices in the project: 

• Controller 
• Dimmer (Theater) 
• Light Switch (Theater) 
• 6-Button Keypad 

Create a new variable—Number 

1 In Composer HE, click Agents. 
2 Select Variables. The Variable Agents view appears. 
3 Click New. 
4 On the dialog that appears, do the following: 

a Select New Variable. 
b Name the variable Keypad releases. 
c Use the Variable Type pull-down menu to select Number. 
d Click OK. 

 

5 In the Variables pane, select the variable Keypad releases. The available variables 
for your devices appear in the right pane. 

6 Enter the value as 0 (zero). 
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Create an event 

7 Click Programming to display the Programming view. 
8 In the project tree and in the Device Events pane, select 6 Button Keypad. 
9 Click Button 1 on the 6-Button Keypad. 
10 Select Press for the event. The event appears at the top of the Script pane. 

Create the actions 

11 In the Actions pane, scroll down to view the agents. 
12 Click to expand Variables. 
13 Select Keypad releases. 
14 Click the Commands tab. 
15 In the Commands tab, select the following to add 1 to the present value: 

a Select the radio button by the plus (+) sign. Ensure the plus sign is selected. 
b Select 1 (one). The action appears in the Actions pane. 

16 Drag the green arrow icon to the Script pane. 

Create the conditionals 

17 Click the Conditionals tab. 
a Select the Is radio button option. 
b Select equals (=) sign. 
c Select 1 (one). 

18 Drag the blue question mark below the previous command in the Script pane. 
This places the conditional Action parallel to the previous Action command. 

19 In the Actions pane, select Theater Dimmer. 
20 In the Command tab, select On. The action command appears in the Actions 

pane. 
21 Drag the green arrow to the blue question mark in the Script pane to make it a 

subset of this conditional item. 
22 In the Actions pane, scroll down to the Agents. 
23 In the Variable agent, select Keypad releases. 
24 Click the Conditional tab. 

a Select the Is radio button option. 
b Select equals (=) sign. 
c Select 2 (two). 

25 Drag the blue question mark to the blank space under the previous Action 
command. This places the conditional Action parallel to the previous Action 
conditional. 

26 In the Actions pane, select Light Switch. 
27 In the Command tab, select On. The action command appears in the Actions 

pane. 
28 Drag the green arrow to the blue question mark in the Script pane to make it a 

subset of the conditional item. 
29 In the Actions pane, scroll down to the Agents list. 
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30 In the Variable agent, select Keypad releases. 

 

31 In the Commands tab, select the following: 
a Select the Set to Value radio button. 
b Set the value to 0 (zero). The Action command appears in the Actions pane. 

32 Drag the green arrow icon to the blue question mark icon in the Script pane to 
make it a second subset of the conditional. 

Using custom variables—String 
Use the Programming and Agent views to create and program with custom String 
variables that have a text-based value.  

Note: The steps in this section are for more advanced users of Composer HE, 
although the steps basically do repeat for each playlist you create. This example 
includes many steps. 

In this example, you will program Button 4 on a keypad to toggle through four 
playlists. 

Prerequisite 

Ensure that the correct devices are added and identified in the project. Your dealer or 
installer can do that for you. 

This example uses the following devices in the project: 

• Controller 
• 6-Button Keypad 
• 4 Playlists: Mom’s Favorites, Dad's Favorites, Choral Music, and Kid’s Music 

Create a new variable—String 

To use a custom agent variable agent string: 

1 In Composer HE, click Agents. 
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2 Select Variables. The Variables agent list appears. 
3 Click New. 
4 On the dialog that appears, do the following:  

a Select New Variable, and name the variable My Playlists. 
b In Variable Type, use the pull-down menu to select String, and then click OK. 

 

Set up Mom’s Favorites playlist in the Theater 

5 Click Programming to display the Programming view. 
6 In Programming, select 6 Button Keypad in the Theater from the Device Events 

pane. 
7 In 6-Button Keypad Events, click Button 4 on the Keypad. 
8 In the Device Actions pane, scroll down and click to expand Variables. 
9 Select My Playlists. 
10 In My Playlists Actions pane, click the Conditionals tab, and enter the name of a 

playlist; for example, Mom’s Favorites. 
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11 Drag the first blue question mark to the Script pane. 

 

12 In Device Actions, select the Theater room object. 
13 In Theater Actions, select Media. 
14 In the window that pops up, select Playlists, Mom’s Favorites, and then click OK. 
15 Drag the green arrow icon on top of the first blue question mark in the Script 

pane to make it the first subset of the first conditional. 

 

16 In Device Actions, select My Playlists. 
17 In the Commands tab under My Playlists, enter the name of the next playlist that 

you’d like to play; for example, Mom’s Favorites. 
18 Drag the green arrow on top of the first blue question mark to the Script pane 

to make it a second subset of the first conditional. 
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The next time you press the button on the keypad, the value of the variable will 
be Mom’s Favorites (Dad’s Favorites is shown below), and then will cue that 
playlist in the Theater. 

 

19 In Device Actions, scroll up and then select the 6 Button Keypad in the Theater. 
20 In 6-Button Keypad Actions, click Button 4. 
21 Click the square of color to choose the color you want Button 4’s LED to be 

when Mom’s Favorites plays. Choose the color in the menu that pops up (in this 
example: green), and then click OK. 
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22 Drag the green arrow on top of the first blue question mark in the Script pane 
to make it a third subset of the first conditional. 

 

23 In Device Actions, scroll down and select Programming Control. 
24 In the Programming Control Actions, select the Stop radio button. 
25 Drag the green arrow on top of the first blue question mark in the Script pane 

to make it a fourth subset of the first conditional. 

Note: It is important to add a Stop command here so that when the conditional is 
fulfilled, the programming does not continue. Because of the way this 
programming is set up when it’s finished, without the stop, the button on the 
keypad always selects the last playlist in the script. 
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Set up Dad’s Favorites playlist in the Theater 

26 In Device Actions, select My Playlists again. 
27 In the Conditionals tab, next to ‘Is’ enter Dad’s Favorites in the text box. 
28 Drag the second blue question mark to the Script pane. 
29 In Device Actions, select the Theater. 
30 In Theater Actions, select Media. 
31 In the window that pops up, select Playlists, Dad’s Favorites, and then click OK. 
32 Drag the green arrow on top of the second blue question mark in the Script 

pane to make it the first subset of the second conditional. 

Set up Kid’s Room playlist in the Theater 

33 In Device Actions, select My Playlists. 
34 In the Commands tab under My Playlist Actions, enter the name of the next 

playlist that you’d like to play; for example, Kid’s Music. 
35 Drag the green arrow on top of the second blue question mark in the Script 

pane to make it a second subset of the second conditional. 
36 In Device Actions, select the 6 Button Keypad in the Theater. 
37 In 6 Button Keypad Actions, click on Button 4. Click the square of color to 

choose the color you want Button 4’s LED to be when Kid’s Music plays. Choose 
the color in the menu that pops up (in this example: purple), and click OK. 

38 Drag the green arrow on top of the second blue question mark in the Script 
pane to make it a third subset of the second conditional. 

39 In Device Actions, select Programming Control. 
40 In the Programming Control Actions pane, select Stop. 
41 Drag the green arrow on top of the second blue question mark to make it a 

fourth subset of the second conditional. 
42 In Device Actions, select My Playlists again. 
43 In the Conditionals tab, enter Kid’s Music. 
44 Drag the blue question mark to the Script pane to make it the third conditional. 
45 In Device Actions, select the Theater room object. 
46 In Theater Actions, select Select Media. 
47 In the window that pops up, select Playlists, Kid’s Music, and then click OK. 
48 Drag the green arrow on top of the third blue question mark in the Script pane 

to make it the first subset of the third conditional. 

Set up Choral Music in the Theater 

49 In Device Actions, select My Playlists. 
50 In the Commands tab under My Playlists, enter the name of the next playlist that 

you’d like to play; for example, Choral Music. 
51 Drag the green arrow on top of the third blue question mark to make it a second 

subset item of the third conditional. 
52 In Device Actions, select the 6 Button Keypad in the Theater. 
53 In 6 Button Keypad Actions, click on Button 4. Click the square of color to 

choose the color you want Button 4’s LED to be when Kid's Music plays. Choose 
the color in the menu that pops up (in this example: red), and click OK. 

54 Drag the green arrow on top of the third blue question mark in the Script pane 
to make it the third subset of the third conditional. 

55 In Device Actions, select Programming Control. 
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56 In the Programming Control Actions, select the Stop radio button. 
57 Drag the green arrow on top of the third blue question mark in the Script pane 

to make it a fourth subset of the third conditional. 
58 In Device Actions, select My Playlists again. 
59 In the Conditionals tab, enter Choral Music. 
60 Drag the fourth blue question mark to the Script pane. 
61 In Device Actions, select the Theater room object. 
62 In Theater Actions, select the Select Media radio button. 
63 In the window that pops up, select Playlists, Choral Music, and then click OK. 
64 Drag the green arrow on top of the fourth blue question mark in the Script pane 

to make it the first subset of the fourth conditional. 
65 In Device Actions, select My Playlists. 
66 In the Commands tab under My Playlists, enter the name of the next playlist that 

you’d like to play; for example, Mom’s Favorites. 
67 Drag the green arrow on top of the fourth blue question mark in the Script pane 

to make it a second subset of the fourth conditional. 
68 In Device Actions, select the 6 Button Keypad in the Theater. 
69 In 6 Button Keypad Actions, click on Button 4. 
70 Click the square of color to choose the color you want Button 4’s LED to be 

when Choral Music plays. Choose the color in the menu that pops up (in this 
example: yellow), and click OK. 

71 Drag the green arrow on top of the fourth blue question mark to make it a third 
subset of the fourth conditional. 

72 In Device Actions, select Programming Control. 
73 In the Programming Control Actions, select the Stop radio button. 
74 Drag the green arrow on top of the fourth blue question mark to make it a 

fourth subset of the fourth conditional. 
75 In Device Actions, select the Theater room. 
76 In Theater Actions, select Media. 
77 In the window that pops up, select Playlists, Mom’s Favorites, and then click OK. 

Note: You do this because the first time you press the button on the keypad, the 
string variable does not have a value, and so nothing happens. This last command 
is created when none of the conditionals are fulfilled, something will play; each 
time the button is pushed thereafter, a conditional is fulfilled. 

78 Drag the green arrow below the previous Stop command in the Script pane. It is 
not a subset of the previous conditionals, but a command on its own. 

79 In Device Actions, select My Playlists. 
80 In the Commands tab under My Playlists, enter the name of the next playlist that 

you’d like to play; for example, Dad’s Favorites. 
81 Drag the green arrow below the previous command in the Script pane. 
82 In Device Actions, select the 6 Button Keypad in the Theater. 
83 In 6 Button Keypad Actions, click on Button 4. Click the square of color to 

choose the color you want Button 4’s LED to be when Mom’s Favorites plays. 
Choose the color in the menu that pops up (in this example: green), and click OK 

84 Drag the green arrow below the previous command in the Script pane. You do 
not need a stop at this point, because the programming automatically stops at 
the end of the script. 
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Programming with agents  
An agent provides the ability to perform complex programming by using functional 
modules. Various types of agents are available, for example, Announcements, Email 
Notifications, Scheduler, Advanced Lighting, Wakeup, etc.  

Example: The Scheduler agent lets you configure dates and times.  

When using agents, you configure them in two parts: 

• In the Agents view, you first define an instance of a type of agent. 
• In the Programming view, you use the instance of the agent for programming. 

Example: In the Agents view, you can create an instance of Custom Buttons where 
you identify all of the buttons you want to create. Then in the Programming view you 
can program the Custom Buttons to perform specific tasks on your devices. 

The “Agent Examples” section can guide you through the process for each type of 
agent available. Agents can vary greatly in functionality.  

Note: Ensure that the devices to which you want to apply the agents are added and 
identified in the system. Your dealer or installer can help you do this. 

Agent types 
Use the Agents view to add agents to your system. 

Available agents: 

• 4Store—Lets you set up and manage 4Store logins, apps, themes, and also 
provides some storage. 

• Access—Lets you hide icons on a Navigator and use a pin code to change the 
settings for the Navigator.  

• Advanced Lighting—Lets you change the lighting state, toggle lights, ramp/fade 
lights, delay on/off, use scene sequencing, flash lights, and so on. In OS 2.3.0 and 
later, this agent mostly supports the Centralized Lighting products with some 
limitations for older lighting devices. 

• Announcement—Provides the ability to play a pre-recorded .WAV file or to 
display a text message whenever a given event occurs. An audio announcement 
can play on any audio output device in the selected rooms. Likewise, a supporting 
text message or stand-alone text message can display on the Navigators in the 
selected rooms. Example: You can create a ”Doorbell” announcement that will 
play a .WAV file (a tone or voice) and display the text message on the Navigators 
“Someone is at the front door” each time someone presses the doorbell. 

• Backup—Configure settings for automatic project backups to Control4 online 
services. Requires a 4Sight subscription. 

• Communication—Replaces the Intercom agent for systems running OS 2.7.0 and 
above. Provides the ability to set up Intercom device groups on the T3 series 
touch screens—audio and video, and legacy touch screens with a communication 
agent compatible driver (5” and 7” In-Wall Touch Screens—audio only, 7” In-Wall 
Touch Screen with Camera, 7” Portable Touch Screen with Camera, and Door 
Station—audio and video) { XE “Communication agent” } 

• Custom Buttons—Lets you create user interface buttons to use for specialized 
devices on the Navigators. See “” in “Agent examples.” 

51 



Composer HE 2.8.0 User Guide  Programming with agents 

• Email Notification—Lets you have an email message sent to your email address 
when specified events occur as defined in programming. 

Notes:  

• 4Sight subscription is required to use the Email Notification and Push 
Notication agents.  

• Avoid setting up email notifications for events that occur frequently (for 
example, when a motion sensor senses motion). If the Email Notification 
trigger event occurs too often, it causes the system to slow down. 

• History—Enables a history tab in drivers built for the history agent, for example, 
new security drivers built for OS 2.8.0. You can configure settings and view 
history data from the agent. 

• Intercom—Provides the ability to set up the Intercom device groups and 
configure Intercom on the 5” and 7” In-Wall Touch Screens (audio only), the 7” 
Portable Touch Screen with Camera (audio and video), the Door Station (audio 
only), or the 7” In-Wall Touch Screen with Camera (audio or video).  

Note: Legacy support only. The Intercom agent cannot be added to a new project 
running OS 2.7.0 or above. 

Example: Set up device groups so you can send out a broadcast to each of the 
supported touch screens in that group. 

• Media Scenes—Lets you create a scene that plays music in selected rooms on 
your Control4 system. 

• Macro—Macro agents associate programming with events.  

Example: You can create one macro to use in several different programming 
events. 

• Push Notification—Lets you define a push notification to be sent to your mobile 
devices as defined in programming. {XE “Push Notification agent” } 

• Scheduler—Defines conditionals of time to the system, and adds the ability to 
have scheduled events. See “Programming with the Scheduler agent” in “Agent 
Examples.” 

• Screen Saver—Lets you set up a Screen Saver agent so you can create various 
screen savers for your Navigators. 

• SNMP Configuration—Lets your dealer set up to receive alerts if your home 
network malfunctions. Check with your dealer for details. 

• Timer—Provides the ability to start a timer, stop a timer, or repeat a timer based 
on a given event and action.  

Example: If a motion sensor in the system turns on a light when it detects motion, 
then a timer can be used to turn off the light after 15 minutes. Alternatively, a 
timer can be set to repeat an action whenever the timer expires. 

• UI Configuration—Upload custom wallpaper images and apply wallpapers from 
both the default set of images and custom images to multiple touch screens at 
once. Supported on T3 touch screens in OS 2.8.0. 

• Variables—A variable is a representation of information about the controlled 
devices, for example, a power state or current level of the device, and it works 
much like a Media Scene. Variables provide other programming options not 
available by using Commands, conditionals, or Loops. There are three kinds of 
variables: 
• Room Variables—Provide you with additional programming options not 

available from the Room object programming. Use Room object 
programming in preference to room variables whenever possible.  
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• Custom Variables—Let you define additional programming options using:  
• Boolean—Provides a true/false option. Example: The light level is 70 

percent. 
• Device—Provides a list of device options. 
• Number—Provides a value option. Example: The light level is 70 percent. 
• String—Provides the option to enter a string. 

• Container Variables—Provide the ability to bind two or more devices 
together using device variables. Container variables are available from the 
Agents view, and by highlighting variables.  

Note: Issues with various implementations have been found. The use of 
container variables for future implementation is not recommended. Where 
possible, replace existing implementations with alternate programming. 

• Wakeup—Has the ability to initiate a pre-specified wakeup time in the Navigators. 
The Wakeup agent lets you play music, turn on lights, and change temperatures. 
See “Programming with the Wakeup agent” in “Agent examples.”  

Agent examples 
Use the Agents and Programming views to create and apply agents to devices in the 
Control4 system. 

The following examples are used in the agents-related sections of this document: 

• “Programming with the 4Store agent” 
• “Programming with the Access agent” 
• “Programming with the Advanced Lighting agent” 
• “Programming with the Announcement agent” 
• “Programming with a Custom Buttons agent” 
• “Programming with the E-Mail Notification agent” 
• “Programming with the Intercom agent” 
• “Programming with the Macro agent” 
• “Programming with the Media Scenes agent” 
• “Programming with the Rhapsody agent” 
• “Programming with the Scheduler agent” 
• “Programming with the Screen Saver agent” 
• “Programming with the SNMP Configuration agent” 
• “Programming with the Timer agent” 
• “Programming with the Variables agent” 
• “Programming with the Wakeup agent” 

Note: Ensure that the devices to which you want to apply agents are added and 
configured in the system. Your dealer or installer can help you do this. 

Programming with the 4Store agent  
Use the Agents view to manage 4Store apps and themes. 

Note: Currently, you cannot perform any programming functions with this agent. 

The 4Store agent provides these functions: 

• Centralized logins. Manage 4Store logins from a central location. 
• Update purchased 4Store apps. Lets you update the list of purchased apps from 
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• Composer HE. 
• Manage themes. Lets you update the list of purchased themes from Composer 

HE. 
• Manage storage. Store purchased apps and themes to other storage devices.  

Note: The Control4 system allows up to 5 MB of files for the 4Store apps and 
themes. Obviously, this is not enough space for very many apps or themes. 
Options are available in this agent to allow additional storage. If you run out of 
space, an error message appears. 

Prerequisites 

• Ensure that you have a valid 4Store account for the system. Go to the 4Store web 
site to purchase apps and themes. 

• Ensure that the storage devices you use (e.g., network file storage and controller) 
have been added and identified in the system. 

To use the 4Store agent: 

1 Start Composer HE and connect to a Director. 
2 Click Agents. 
3 In the Agents pane, select 4Store. 
4 Click Add again (in the 4Store bar) to add accounts. 
5 Enter the 4Store login and password, and then click Save. The login information 

appears in the 4Store Accounts list. Use this list to add, locate and log in to your 
customer's 4Store accounts. After you’ve logged in, you can update their account 
and keep track of which apps and themes they’ve purchased. 

 

6 Select an account in the list to log in to 4Store. The Account Properties pane is 
populated with the information you added when you saved it. Click Activate to 
log in to that account. Note: When you log in to an account from Composer, all of 
the Navigators are logged into 4Store. 
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To select the storage: 

1 Use the File Storage Locations drop-down list and select what to store your apps 
and themes to. After you select the storage device, click Update to transfer the 
apps or themes to the new location. 

2 Click Set. 

 

To update the apps and themes purchased for an account: 

1 Click Update at the bottom of the page. This not only updates the list, but also all 
of the Navigators attached to this Control4 system. When you update, the list 
populates with the account's apps and themes and their size. 

Programming with the Access agent 
Use the Agents view to configure the Access agent to allow or deny access. The 
Access agent is ideal for commercial applications including hotels, bars, or board 
rooms where settings need to be locked or hidden to restrict their use by 
unauthorized personnel. By adding this agent to a project, an access code is required 
to gain access to selected functions of the Status Bar or the More and Settings 
buttons. When enabled, the Access agent settings apply to all touch screens and on-
screen Navigators in the system.  

Status Bar buttons 
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The Access agent provides these key features: 

• Access Code—Using this agent within Composer Pro, the programmer can 
establish a four-digit access code to globally restrict access to the Status Bar, 
More and Settings buttons. Check with your dealer for details. 

• Status Bar Lock—The Control4 Home, Back, Favorites, Room Selector and 
Intercom buttons available on the Status Bar can all be locked so that a user must 
first enter the Access Code to use these features. 

• Status Bar Hide—The Favorites and Room Selector functions can be hidden from 
users. 

• More and Settings Button Lock—The More button on the Control4 Home Screen 
and the Settings button within More can be locked. 

• Localization—For English-speaking locales, the Access agent keypad user 
interface includes Latin characters for users that use a mnemonic to remember 
their Access Code. Non-English speaking locales display only the numerals. 

Prerequisites 

• Figure out which Status Bar or More button functionality you want to restrict or 
hide from unauthorized users. For example, do you want to lock the Room 
Selector? Keep others from getting into Settings? 

• Establish an access code. 

Usage 

To use the Access agent: 

1 Start Composer HE and connect to a Director. 
2 Click Agents. 
3 Select Access. 
4 In the Access Code pane, enter a four-digit access code on the numeric keypad. 

This is the code you’ll use to manage access to icons in the Navigators. 
5 Click Set Access Code. The new access code appears in ‘Current Access Code’ 

window. 
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The following settings are available to the programmer as indicated by the names 
next to the drop-down selectors: 

• Access Agent—To enable or disable the Access agent, use the arrow drop-down 
list, and then select Enabled or Disabled. Disabling the Access agent enables the 
programmer to keep all the current Access agent settings, but disable its use 
while testing Flash Navigator functionality. 

• Hide Digits—To hide or display the access code digits when entered on the Flash 
Navigators, use the arrow drop-down and then select Enabled or Disabled. By 
enabling Hide Digits, an asterisk symbol (*) will appear in place of each digit as it 
is entered. 

• Control4 Home—To lock or unlock the Control4 Home button on the Status Bar, 
use the arrow drop-down and then select Unlocked or Locked. If locked, enter 
the access code after pressing this button before returning to the Control4 Home 
screen. On the on-screen Navigator, the Control4 Home button is accessed using 
the Control4 SR-250 or SR-150 remotes. By locking this feature, you must enter 
the access code after pressing the Control4 button on the remote control. 

• Back Button—To lock or unlock the Back button on the Status Bar, use the arrow 
drop-down and then select Unlocked or Locked. If locked, you must enter the 
access code after pressing this button before returning to the previous screen. 

• Favorites—To lock, unlock or hide the Favorites button on the Status Bar, use the 
arrow drop-down, and then select Unlocked or Locked or Hide. If locked, you 
must enter the access code after pressing this button before accessing the 
Favorites functionality. If hidden, the Favorites button is not displayed. 

• Room Selector—To lock, unlock or hide the Room Selector functionality on the 
Status Bar, use the arrow drop-down, and then select Unlocked or Locked or 
Hide. If locked, you must enter the access code after pressing this button before 
accessing the Room Selector functionality. If hidden, the current room is 
displayed and the user cannot change rooms from the Flash Navigators. 

• Intercom—To lock or unlock the Intercom button on the Status Bar, use the 
arrow drop-down, and then select Unlocked or Locked. If locked, you must enter 
the access code after pressing this button before accessing the Intercom 
functionality. 

• Settings—To lock or unlock the Settings button within the More screen, use the 
arrow drop-down, and then select Unlocked or Locked. If locked, you must enter 
the access code after pressing this button before accessing the Settings 
functionality. 

• More—To lock or unlock the More button on the Home Screen, use the arrow 
drop-down, and then select Unlocked or Locked. If locked, you must enter the 
access code after pressing this button before accessing the More functionality. 

• Edit Lighting Scenes—To lock, unlock or hide the Edit Lighting Scenes 
functionality from within the Lighting screens (available with OS 2.3.0 or later), 
use the arrow drop-down, and then select Unlocked or Locked or Hide. If locked, 
you must enter the access code after pressing this button to access the Edit 
Lighting Scenes functionality. If hidden, the Edit Lighting Scenes functionality will 
not be accessible to users. 

As a reminder, the current implementation of Access agent enables the programmer 
to globally restrict certain features and settings from all users on touch screens and 
on-screen Navigators. Any changes to Access Codes or these settings can only be 
made using Composer Pro. If the Access Code is lost or forgotten, it can be recovered 
only using Composer Pro. Contact your dealer if you forget your Access Code. 
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Keypad user interface and localization 

When the Access agent is enabled, an Access agent keypad displays on the user’s 
touch screens and on-screen Navigators based on the settings described above. A 
picture of this new user interface component is shown below. When entering the 
access code, the user can cancel the process or delete an incorrect digit from their 
current entry. 

Access agent keypad for English locales: 

 

Access agent keypad for all other locales: 

 

Note: Cancel, Delete and Enter are translated into the local language, where available. 

Programming with the Advanced Lighting agent 
Use the Agents and Programming views to program this agent. (This agent support 
current lighting products with full functionality. Older lighting products are also 
supported, but with limited functionality.) 

The Advanced Lighting agent provides these features: 
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• LED tracking for lighting scenes 
• Toggle lighting scenes 
• Ramp and fade lighting scenes 
• Set delays within lighting scenes 
• Scene sequencing 
• Flash lights in lighting scenes 

To use the Advanced Lighting agent: 

1 Start Composer HE and connect to a Director. 
2 Click Agents. 
3 In the Agents pane, select Advanced Lighting and then click New. 
4 Enter a name on the dialog that appears, e.g., Party Lights. 
5 Click Create. Note: You can click the Rename button to rename a scene. 
6 Adjust the scene as desired. 

• Show flash option—Select this option to add a Flash check mark in the list of 
lighting devices below. When Flash is checked, lights can flash on and off at 
set intervals. Use this option with the Delay option. For example, this option 
works well in a situation where you want to alert someone by setting a porch 
light to flash in case of an emergency or to get someone’s attention. Note: 
For older lighting devices (earlier than OS 2.3.0), flashing is not supported. 

• Activate Scene—Click this button to activate the scene immediately. Note: 
The Execute On and Execute Off buttons do not appear in the Advanced 
Lighting agent. Use the Activate Scene button. 

• Sync This Scene—Click this button to synchronize all the lights in this scene 
with the scene settings. 

• Sync All Scenes—Click this button to synchronize all the lights with all scene 
settings.  

• Colors—This is the keypad color. Click the Active or Inactive colored boxes 
to select another color. 

• Tracking—Click All Loads to track a dimmer or switch by name, tracking 
status, delay, rate, level %; and all loads must match their tracking condition 
before the scene will be considered active. Click Any Load and only a single 
load needs to match their tracking condition before the scene will be 
considered active. 

• Hold Rates (sec)—Use the up or down arrows to select the Up hold ramp 
rate or Down hold ramp rate. At the keypad, you press and hold for a set 
period of time in seconds. This action behaves the same as hold rates for 
dimmers. 

• Toggle Scene—This drop-down list lets you choose which scene to activate 
when the current scene is prompted to deactivate. This applies to all scenes 
except for the current one selected. Here, you can toggle scenes on or off. 
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Example: Create an advanced lighting scene called “Dining.” Notice the 
number of switches and dimmers in the Advanced Lighting pane and their 
values. 

 

Create a Dining ‘Toggle’ scene. Notice the difference in switches and dimmers 
and their values from the previous screen. 

 

Now have your dealer use Composer Pro to connect the keypad bindings on a 
3-Button Keypad. 

When you toggle the 3-Button Keypad in the Dining room, various lights go 
on or off at various levels.  
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In the Agents view, check out the following options: 

• Toggle Scene/Create Default—Click Create Default to create a toggle 
scene as a copy of the selected scene. From the copied scene, you can 
rename the new scene and adjust the values on some of the dimmers or 
switches in that scene. 

• Current State—Shows ‘Active’ when the conditions are met to consider 
the scene Active or Inactive if the conditions have not been met.  
• Click Add/Remove Load to add or remove specific dimmers or 

switches associated with the scene. 
• Check the lighting loads that you want to add, and then click OK. This 

can be a single light, a single room, all lighting loads in an entire 
house, or any combination of these options. 

7 Assign the settings for each load:  

• Dimmer and Switch Options: 
• Name—The top line is the room, and the bottom line is the name you 

assigned to the dimmer or switch. 
• Tracking—This lets you track the lights in the system. Use the down 

arrow to select one of these options. 
• Don’t Track—Tracking is ignored. 
• Is Off—Track when the dimmer or switch is off. 
• Is On (Any Level)—The text displays only if the light is a dimmer. 

Switches just indicate ‘Is On.’. 
• On At Level (%)—Track when the dimmer is on at a specific level. 
• At Scene Final Level—Track at the final level of the last sequence. 

For example, if someone changes the level on a Navigator, this might 
be the final level. 

Delay—Use the up or down arrows or type the delay value in seconds. 
Tip: If you have several dimmers in a long hall, and you want to set up 
sequencing, you can use this option with the green + buttons and 
increase the delay of each dimmer in a row by two seconds. 

• Rate—Set the ramp rate, which is the speed the load ramps to for the 
specified lighting level. Use the up or down arrows to set the milliseconds 
(ms), seconds (sec), or minutes (min) of the ramp rate. Then set the 
amount of time the device takes to change the level.  

Example: Set the time to 1 second for both the Bedroom Dimmer and the 
Theater Dimmer. 

• Level (%)—Set a target lighting level as appropriate by using the drop-
down menu, for example, 50 percent for the Bedroom Dimmer and 20 
percent for the Theater Dimmer. The green + gives you the ability to add 
‘paths’ to a scene. Each row in the path uses single delay/rate/level 
settings. Use the green + to add another step, click the red x to delete a 
step, or you don’t need to have any steps. Note: Older lighting devices 
(prior to OS 2.3.0) only allow 0 or 1 steps. 

• Apply To—Click this option to allow other lights to use the same scene. 
• Ignore Scene Ramp/Fade—Check this option to have the light ignore 

commands to ramp or fade a scene. 
• Graph—Shows in graphical form (red lines) the settings for each dimmer 

or switch. Dimmers will show ramp rates, delays, and levels as angled, 
horizontal, or vertical lines.  

• Graph Scale—Select the time, in seconds, that you want to show the light 
levels. 
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8 Now click Programming—To program a scene, follow the basic steps in 
“Programming Basics for Control4 Systems.”  

Note: This agent has ‘read-only’ variables for the length of each scene.  

Example: Note the screens below.  

Event: (Is Invoked, Becomes Active, Becomes Inactive) 

• Is invoked—This event fires when the scene has been explicitly told to 
activate. If the scene is already activated, and it is told to activate again, this 
event will still fire. 

• Becomes Active—This event fires when the scene transitions from the 
Inactive state to the Active state. 

• Becomes Inactive—This event fires when the scene transitions from the 
Active state to the Inactive state. 
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Actions—(Activate, Deactivate) 

 

A programming example for use with the Advanced Lighting agent might be in a 
case where, if the front door opens and it’s past 9 PM at night, all the lights turn 
on in the home at various levels. 

Programming with the Announcement agent 
Use the Agents and Programming views to program this agent. 

You can create an announcement that 

• Displays a text-message or web page on any of the graphical Navigators (TV on-
screen menu, touch screens, or Control4 apps) 

• Plays a WAV-formatted audio announcement through any audio endpoint  
• Or a combination of the two 

Note: The Control4 system allows up to 10 MB of files for the Announcement agent, 
and plays a maximum of 15 seconds per announcement. 

Example: Create a 'Dinner is Ready' announcement that is activated when the family 
chef presses a custom-programmed button. When the button is pressed, the text 
message “Come to Dinner Now!” displays on all of the on-screen Navigators and touch 
screens in the home while an audio file plays a dinner bell ringing. 

Prerequisites 

Ensure that the devices to which you want to apply agents are added and identified in 
the system. Your dealer or installer can help you do this. 

This example uses the following devices in the project: 

• A controller 
• An audio output device (for example, a TV or connected speakers) 
• A Navigator with a screen (touch screen, TV on-screen Navigator, or Control4 

app) 
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• Any device involved in the triggering event (for example, a Doorbell Contact, 3-
Button Keypad, etc.)  

To create a new Announcement agent: 

1 Start Composer HE and connect to a Director. 
2 Click the Agents view. 
3 In the Agents pane, select Announcements.  
4 Click New. 

Announcements agent: 

 

5 With Announcements selected in the agents <name> pane, click New. 
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6 Add a name to the new announcement, and then click Create. 

 

7 Set up the Navigator text message to be displayed. 
a Check the Display Navigator Text/Image Popup box. 
b Click Edit Text/Image. 

 

c Enter a text message, a URL, or browse to an image (JPG, GIF, or PNG) to be 
displayed. 

The text box accepts any HTML code. While certain links and scripts won’t 
be handled, when the announcement is triggered, for example, if you put this 
text in an announcement, it will show up just as if it were a web page.  

The following text will display the latest snapshot of a web page: 

<HTML><BODY><IMG 
SRC="http://tbn0.google.com/images?q=tbn:1uOhCnlc3zbQgM:http://www.inkycircus.c
om/jargon/images/mountain.jpg" ALT="pumpkin"><a 
href="http://www.w3schools.com/">Visit W3Schools!</a></BODY></HTML> 

Note: A static image file (JPG, GIF, or PNG) only has to be added to your 
project one time, because it is copied to the controller. When added, it is 
available in the Text Message drop-down list for use in any additional 
announcements created.  

d Select the time you want the text message to display by selecting a Close 
after drop-down option (supported display times are from 5 seconds to 10 
minutes). 

e Click Add/Remove and add the Navigators that will display the message. 
Click OK. 
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8 Audio file. Add a WAV audio file and set up the audio file to play (see the figure 
below). 

 

a Check the Play Audio File (.wav) box. 
b (One time per audio file.) Click Add and browse to the .WAV audio file to add 

it to the drop-down list. 

Note: An audio file only has to be added to your project one time, because it 
is copied to the controller. When added, it is available in the Audio File drop-
down list for use in any additional announcements created.  

c Choose the WAV file from the drop-down list. 
d Click Add/Remove Rooms and add the rooms where the audio file will play. 
e Set the volume of the audio play for each room.  
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Note: Volume for the announcement can be set only on devices with discrete 
volume control. 

 

9 Click the Programming view. 
10 Verify that the new Announcement agent displays in the Actions list (bottom of 

list). 

 

a Select Announcements. 
b Make sure the 'Come to Dinner Now!' message displays in the Announcement 

Actions pane, and that the command is there (green arrow). 
11 Program the announcement to play or display with a triggering event.  

Example: Program a button-press event (left pane) to trigger the Announcement 
agent “Come to Dinner Now!” (right pane) to run. 
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Programming with the Backup agent 
Use the Backup agent to configure automatic backups to Control4 online services.  

Note: Automatic backups to Control4 online services require a valid 4Sight 
subscription. Contact your Dealer to renew or start your 4Sight subscription. 

To configure automatic project backups using the Backup agent: 

1 In the Agents tab, select the Backup agent. 
2 Check the box next to Scheduled Backups to enable automatic backups. 
3 Choose which additional information to include in your automatic backups: 

• Usernames, passwords, and personal information 
• Media 
• Cover Art 
• Screen saver images 
• Announcements 
• Wallpaper 

4 Select the date and time to perform the automatic backup. Control4 will save the 
last seven backup files online. 

5 Click Save or Save and Back Up Now. 

 

Programming with a Custom Buttons agent 
Use the Custom Buttons agent to create up to four custom screens to display on the 
Navigators (including touch screens and on-screen TVs). 

Example: If you have a heated driveway or some other specialty device, you can set 
up a screen with custom buttons to operate the heated driveway from your 
Navigators. 

Guidelines 

• You can access each screen on the Navigators from the Control4 main menu or 
for a room from four available tabs. For example, the heated driveway screen is 
accessed from a custom tab on the main menu. You can configure the tab to be 
viewed system-wide on all screens, or to view in one room. 

• The Navigators allow up to four tabs per room to access custom screens with 
custom buttons. Each screen can provide up to six custom buttons for a total of 
24 custom buttons. The four tabs in each room can be allocated either as room or 
global tabs. 

• On the Navigators, you can set up a room or global tabs. The example below 
shows the creation of custom tabs that appear in the Kitchen to access a custom 
screen. 

Note: If you want to create a Custom tab to appear globally, check the Global box 
next to the Screen Name. Because only four screens are available for each room, if 
a Global button is added and another room already has four screens, the Global 
button replaces the first screen in that room. 

Prerequisites 

• Ensure that the correct devices are added and identified in the project. 
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This example uses the following devices in the project: 

• Controller 
• Electronic Gate (In the Control & Audio Video Connections tab, ensure that 

the Electronic Gate is connected to controller Relay Port 4.) 

To set up a Custom Buttons agent: 

1 Start Composer HE and connect to a Director. 
2 Click Agents. 
3 Choose Custom Buttons. 
4 From the list that appears in the left pane, select the room for the Custom Button. 
5 For example, select Kitchen. 
6 When the Custom Buttons interface appears, in the Screen x area, click Add. 

 

7 Enter the name of the buttons that will appear on the Navigator. 
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8 Enter the relevant information for the device. 

The Screen Name is the name that appears on the access tab to enter the custom 
screen. The buttons are the names that appear on the custom buttons. 

Example: For the Garage Door, enter the following: 

• Screen Name: Garage Door 
• Button 1: Toggle 

9 Click OK. 
10 Click the Programming view to program your custom buttons. 
11 In the Device Events pane, scroll down to the agents and select the Custom 

Buttons agent. 
12 In the Custom Buttons Events pane, ensure that Family-Garage Door is selected 

under the Event Screen next to Toggle, and then select the Press radio button. 
When custom button ‘Toggle’ on screen ‘Garage Door’ in Front is pressed, it 
appears at the top of the Script pane. 
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13 In the Actions pane, select Garage Door. 
14 From the Command tab, select the Toggle the Garage Door radio button. The 

action command appears in the Actions pane. 
15 Drag the green arrow to the Script pane. 
16 Select File > Refresh Navigators. 

Programming with the E-Mail Notification agent 
Important: An active 4Sight Internet Service subscription is required for Email 
Notification to work. See the Control4 System User Guide for details. 

Use the Control4 Composer HE E-Mail Notification agent to have an email message 
sent to an email address automatically when specific events occur that you define in 
programming. 

Example: If you want to know when the basement door opens, you can set up an 
Email Notification agent to send an email message to your Inbox when the basement 
door is opened. 

• The Email Notification agent is a Control4 service. To use the Email Notification 
agent, Remote Access is required to facilitate a secure connection between the 
controller and the Control4 service. 

• The Email Notification agent uses templates to enhance usability. You can use a 
template to define a To, Subject, or Body for use when creating instances of the 
Email Notification agent. See "Connecting to a Director" or "Setting Up Remote 
Access" in Composer HE Getting Started. 

• Use the Programming view to define the individual instance that triggers an e-
mail and completes the definition. 

Example: A security threat to the house notified you of broken windows, doors 
opening, and motion detected in Away mode. In the template, you define Subject: 
Security Alert and To: fsmith@myemail.com. In the Programming view, you might 
define the zone. Examples of other incidents to use Email Notification include: 
Basement Door Opened, Front Gate Opened, Water Sensor detection, Carbon 
Monoxide Sensor detection, Motion Sensor detection, Sprinklers On/Off, etc. 
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Tip: When setting up an Email Notification agent, note the frequency that an event 
can happen, because if it is too frequent, it can slow down the system. For example, if 
an email is sent when a motion sensor detects motion, the frequent email messages 
could slow things down. 

Prerequisites 

Ensure that the correct devices are added and identified in the project. Your dealer or 
installer can help. 

This example uses the following devices in the project: 

• Controller 
• Door Contact Sensor 

To set up an E-Mail Notification agent: 

1 Start Composer HE and connect to a Director. 
2 Click Agents. 
3 In the Agents pane, select Email Notification, and click Add. The New Template 

Name dialog appears. 

Tip: Control4 now includes Control4 system and user-defined variables in the 
templates created using this agent. To use this function, your installer can create 
or modify email templates using Composer HE, agents, Email Notification, and 
then use the Add Variable option. 

4 Enter a name on the dialog that appears, for example, 'Security Alert.' 
5 Click Create. 
6 In Email Notification Template Name, select Security Alert for the Composer 

email screen to appear. 
7 Fill out the information for the email you want sent to you when an event occurs. 

Example: 

To: fsmith@myemail.com 

Subject: Security Alert 
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Body: The security of the Franklin Smith House may have been 
compromised. 

 

8 Do the following as needed: 
a Click Send Email to test whether you receive an email to your email address. 
b Click Save to exit and go to the Programming view to set up the 

programming. 
c Click Reset to clear the To, Subject, and Body of the email to start again. 

9 With the Agent template created, you can create one instance of the Security 
Alert for each security zone (or object).  

10 Click Programming to display the Programming view. 
a In Programming under Theater, select Door Contact Sensor. 
b In Door Contact Sensor Events, select When Door Contact Sensor opens. 
c In the Actions pane, scroll down and select Email Notification. 
d Make changes to the email as necessary. 
e Drag the green arrow to the Script pane. 

11 In the File menu, click Refresh. 
12 Test the Email Notification agent by going to the door and opening it. An email is 

sent to your Inbox with the ‘Security Alert’ as the subject. 

Programming with the Push Notification agent 
Important: An active 4Sight Service subscription is required for push notifications to 
work. See the Control4 System User Guide for details. 

Use the Control4 Composer HE Push Notification agent to have a push notification 
sent to a mobile device automatically when specific events occur that you define in 
programming. 

Example: If you want to know when the basement door opens, you can set up a Push 
Notification agent to send a notification to your mobile device when the basement 
door is opened. 
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• The Push Notification agent is a Control4 service. To use the Push Notification 
agent, Remote Access is required to facilitate a secure connection between the 
controller and the Control4 service. See "Connecting to a Director" or "Setting Up 
Remote Access" in Composer HE Getting Started. 

• The Notification agent uses templates to create notification messages. You can 
use a template to define a Category, Severity, Subject, or Message for use when 
creating instances of the Notification agent. 

• Use the Programming view to define the individual instance that triggers a 
notification and completes the definition. 

Example: A security threat to the house notified you of broken windows, doors 
opening, and motion detected in Away mode. In the template, you define Category: 
Security, Severity: Alarms, and Subject: Security Alert. In the Programming view, you 
might define the zone. Examples of other incidents to use Notification include: 
Basement Door Opened, Front Gate Opened, Water Sensor detection, Carbon 
Monoxide Sensor detection, Motion Sensor detection, Sprinklers On/Off, etc. 

 

Prerequisites 

Ensure that the correct devices are added and identified in the project. Ensure that 
your mobile device shows in your Control4 account on customer.control4.com. Your 
dealer or installer can help. 

 

This example uses the following devices in the project: 

• Controller 
• Door Contact Sensor 

To set up a Push Notification: 

13 Click Agents. 
14 In the Agents pane, select Push Notification, and click Add. The New Push 

Notification dialog appears. 
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Tip: Control4 includes Control4 system and user-defined variables in the 
templates created using this agent. To use this function, your installer can create 
or modify notification templates using Composer HE, agents, Notification, and 
then use the Add Variable option. 

Tip: Push Notification content is modified in the Agents view and any changes are 
automatically updated to any programming associated with the individual Push 
Notification.  

15 Enter a name on the dialog that appears, for example, 'Security Alert.' 
16 Click Create. 
17 In Push Notifications pane, select Security Alert for the Push Notification screen 

to appear. 
18 Fill out the information for the notification you want sent to you when an event 

occurs. 

Example: 

Category: Security 

Severity: Alarms 

Subject: Security Alert 

Message: The security of the Franklin Smith House may have been 
compromised. 

 

19 Log in to your customer.control4.com account to manage delivery of push 
notifications to your mobile devices. 

20 Do the following as needed: 
a Click Send Push Notification to test whether you receive the notification on 

your mobile device. 
b Click Save to exit and go to the Programming view to set up the 

programming. 
c Click Reset to clear the Subject and Message of the notification to start again. 
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21 With the notification created, you can create one instance of the Security Alert for 
each security zone (or object).  

22 Click Programming to display the Programming view. 
d In Programming under Theater, select Door Contact Sensor. 
e In Door Contact Sensor Events, select When Door Contact Sensor opens. 
f In the Actions pane, scroll down and select Push Notification. 

 

Programming with the History agent 
Use the History agent to enable your Control4 system to record a history of system 
events. These events give the user or dealer a better record of system events and 
when they happened. To view a history of events in a Navigator interface, the driver 
being viewed must support the History agent. Starting in OS 2.8.0, support for the 
History agent is included with some newly released security system drivers. Contact 
your dealer for more details. 

To configure the History agent: 

1 In Agents, select the History agent, and click on the Configuration tab. In this tab 
you can configure how the event history is stored and viewed. You can: 
a Define the History Storage Window (how long system events will be 

recorded).  
b Choose the History Storage Size (maximum number of records).  
c Choose the Max Result Set Size (maximum size of a search result). 

2 Click the box next to Record System Events to enable system events in the 
history data. 

History data saved by the History agent can be viewed in Composer. 

To view History Data: 

1 In Agents, select the History agent, and click on the History Data tab.  
2 Choose which categories to filter the history data. You can filter by: 

• Date/Time 
• Severity 
• Name 
• Category 
• Subcategory 
• Type 

3 Click Query History to search the history data. 
4 Select the number of results wanted and click Get Next to retrieve more results.  
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Programming with the Intercom agent 
Important: With OS 2.7.0 and the new T3 touch screens, the Communication agent 
replaces the Intercom agent. If you only have existing touch screens and had 
previously configured the Intercom agent, you may continue to use the Intercom 
agent. If you are configuring Intercom for the first time in OS 2.7.0 or above, or need 
to add any T3 touch screens to an already configured Intercom system, you must use 
the Communication agent. See “Programming with the Communication agent” in this 
document. Before you attempt to remove the Intercom agent or add the 
Communication agent, please contact your dealer to see if additional steps are 
required from the dealer before you configure the agents. 

The Intercom agent lets you configure the 5" or 7" In-Wall Touch Screens (supports 
audio intercom only), the 7” Portable Touch Screen with Camera, the Door Station, or 
the 7” In-Wall Touch Screen with Camera (supports audio and video intercom) so that 
the Control4 system acknowledges the Intercom system and can communicate with 
it.  

Note: Only these touch screens models are capable of Intercom functionality. 

Note: This agent also lets you configure third-party PBX systems for multi-dwelling 
units (MDUs) using the SIP Proxy tab (for a future release). See “SIP Proxy Tab” below 
for more information. 

Caution! The SIP Proxy tab is for advanced users only; or those who understand how 
to set up and use SIP and a PBX system. See your SIP specialist and PBX administrator 
for details. 

With the Intercom agent, you can send broadcasts to touch screens, monitor a room, 
and other controls.  

Example: If you have an elderly parent living in their own home, you can create a 
macro and assign it to a keypad button. If your family member is in stress, they simply 
press the keypad button to notify you that something is wrong. Another example is a 
“Good Night” setting where all touch screens in the house can be set to “Do Not 
Disturb” when it’s time to go to sleep. Or you can monitor your kids’ rooms after 
they’ve gone to bed to ensure that they’re going to sleep when they should.  

Example: This example demonstrates how to send a ‘test’ announcement to a touch 
screen in the Master Bedroom that indicates that the Master Bedroom is being 
monitored. 

Tip: Many of the steps below (creating or removing groups, adjusting settings, etc.) 
can be performed on the supported touch screens. See the System User Guide for 
details. 

Notes: (1) Broadcasting does not work in a room that’s being monitored if that room is 
in Monitor Mode. When in Monitor Mode, you will not want the person in that room to 
be disturbed, for example, a sleeping child. (2) Before you use broadcasting, make 
sure your WiFi router is set to allow multicasting. Some routers do not allow 
multicasting. Check with your dealer for details. 

Prerequisites 

The example below uses the following devices in the project: 

• Controller  
• 7" In-Wall Touch Screens 
• Intercom license 
• Intercom agent (see below) 
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• Kitchen 
• Master Bedroom 
• Macro agent 

Note: An Intercom license must be assigned and active on your account. Check with 
your dealer for details. 

To set up an Intercom agent: 

1 Start Composer HE and connect to a Director. 
2 Click the Agents view.  
3 In the Agents pane, select Intercom. 

 

Add new Intercom group 

To add an Intercom group: 

An Intercom group is a set of Intercom-supported touch screens identified by a 
specific group name. This saves time when you want to send a broadcast to a group 
of people.  

Example: You can create a group (John’s Group) and then send a broadcast to that 
group. 

You can create Intercom groups (groups of touch screens) and send broadcast 
messages them. 

1 Select Intercom in the Intercom Groups pane, and click New. 
2 Name the Intercom group, and click Add. Example: “John’s Group.” 
3 Add the devices to the new group (see “Intercom Devices Tab” below). 
4 Adjust the settings for each touch screen (see “Intercom Devices Tab” below). 

Intercom Devices tab 

Group properties: 
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You can add devices to an existing group of 5" or 7" In-Wall Touch Screens, 7” In-Wall 
Touch Screen with Camera, or 7” Portable Touch Screen with Camera, or Door 
Station. This lets the broadcaster from one touch screen send out broadcasts to the 
group of devices. 

To add or remove devices in a group: 

• Add: Select the device in the Intercom Devices tab, and then click Add. Click OK. 

- OR - 

Remove: Select the device in the right box of the Intercom Devices tab, and then 
click Remove. Click OK. 

Intercom device properties: 

Important: Make sure you review with your dealer all of your Intercom settings for the 
supported touch screens with and without cameras in OS 2.2 or later before your 
dealer finishes the upgrade. For example, if Auto Answer was disabled in Intercom V1, 
the settings do not transfer when you upgrade a system to Intercom V2 in OS 2.2 or 
later. Auto Answer is ON by default for Intercom V2 in OS 2.2 or later. If you want Auto 
Answer disabled, the best method is to disable Auto Answer on all touch screens using 
the Intercom agent under Intercom Device Properties. Otherwise, you will have to go 
to the settings in each touch screen and disable them manually. 

To add or remove settings for each touch screen: 

1 Use the Intercom Devices tab to change the settings for each supported touch 
screen. 

• Manual Answer Popup Timeout (seconds): Use the up or down arrow keys 
or type how much time is allowed to answer an incoming call. 

You can set the following options for each touch screen in the Intercom Device 
Properties pane: 

• Exclude from Navigator: Select if you do not want these options enabled. 
This option is useful when you want to broadcast messages to the touch 
screens. 

• Ringtone on doorbell press—On touch screens, plays a ringtone when a 
door station doorbell is pressed. 

• Do Not Disturb: Select to enable. When a broadcast or call tries to connect 
to another touch screen (for example, John’s Room), the message or call is 
blocked, and the caller’s touch screen displays a ‘Do Not Disturb’ or ‘Station 
Busy’ message from the ‘John’s Room’ touch screen. On the caller’s touch 
screen, tap Close to close the message. 

• Auto Answer: Select to enable. When a call comes in from another touch 
screen, that touch screen rings and the caller's voice is heard (and video if 
activated). John, for example, (or whoever is in John's Room) can then speak 
to the caller from his or her touch screen. 

• Send Video: (not supported on 5” In-Wall Touch Screens or 7” In-Wall Touch 
Screens). Select to enable. When a call comes in from another touch screen, 
the touch screen rings and the caller's voice and video appear (if activated) 
on the caller's touch screen. John, for example, (or whoever is in John's 
Room) can speak into his or her touch screen and the caller can see them on 
the screen. See the Control4 System User Guide for more details and 
examples. 
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• Monitor Mode: Select to enable. This monitors a room through the touch 
screen in that room. This option sends audio and/or video to the touch 
screen that is monitoring another room, for example, John’s Room. See 
“Monitor a Room” in the System User Guide for more details. 

2 Click Apply Changes when you're finished. 

SIP Proxy tab 

The columns used in this tab are for SIP (session initiation protocol) and an external 
PBX service. To enable SIP for an MDU, see your SIP specialist.  

Configure: 

The Domain and TSL Port columns use the default. These are populated by Director. 

Caution! Do not change these values unless under extreme circumstances, and you 
know exactly what you are doing. 

Routes: 

To add values to the URI, Method, Event, Destination, and Order columns, see a SIP 
specialist. 

Users: 

The user@domain, Name, and E-Mail columns are used for troubleshooting purposes. 
See your SIP specialist. These are Intercom-supported Control4 devices. 

Registrations: 

The AOR, Contact, Instance ID, Reg ID, and Expires in (sec) columns are used for 
troubleshooting purposes. See your SIP specialist. These are users who are registered 
via Director. 

Tip: Your PBX administrator may benefit by going to these sites: 

• http://www.reciprocate.org/using repro. Explains how URI works. 
• http://wwwregular.expressions.info/tutorial.html. Explains how regular 

expressions work. 

Programming with the Communication agent 
The Communication agent lets you configure the 5" or 7" In-Wall Touch Screens 
(supports audio intercom only), the 7” Portable Touch Screen with Camera, the Door 
Station, the 7” In-Wall Touch Screen with Camera, or the 7” In-wall,  10” In-Wall, and 7” 
Tabletop T3 Touch Screens (supports audio and video intercom) so that the Control4 
system acknowledges the Intercom system and can communicate with it.  

Important: Check with your dealer before using this agent to see if additional steps 
are required from your dealer. 

Note: This agent also lets you configure the intercom to allow third-party devices 
(External Devices) for multi-dwelling units (MDUs). This functionality requires 
additional training and hardware not covered in this document. 

With the Communication agent, you can send calls to multiple touch screens, monitor 
a room, and other controls.  

Examples:  
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• If you have an elderly parent living in their own home, you can create a 
macro and assign it to a keypad button. If your family member is in stress, 
they simply press the keypad button to notify you that something is wrong.  

• Create a “Good Night” setting where all touch screens in the house can be 
set to “Do Not Disturb” when it’s time to go to sleep.  

• Monitor your kids’ rooms after they’ve gone to bed to ensure that they’re 
going to sleep when they should.  

Notes: (1) Broadcasting does not work in a room that’s being monitored if that room is 
in Monitor Mode. When in Monitor Mode, you will not want the person in that room to 
be disturbed, for example, a sleeping child. (2) Before you use Intercom with touch 
screens connected over WiFi, make sure your WiFi router is set to allow multicasting. 
Some routers do not allow multicasting. Check with your dealer for details. 

Prerequisites 

 

• Controller  
• 7" In-Wall Touch Screens 
• Communication agent (see below) 

Note: An Intercom license must be assigned and active on your account. Check with 
your dealer for details. 

To set up the Communication agent: 

1 Click the Agents view.  
2 In the Agents pane, select Communication. If the Communication has not been 

added already, click Add, highlight Communication in the list, and click OK.  

Important: Check with your dealer before using adding the agent to see if additional 
steps are required from your dealer. 

 

–  
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Add new Intercom group 

To add an Intercom group: 

An Intercom group is a set of Intercom-supported touch screens identified by a 
specific group name. This saves time when you want to send a call to a group of 
people.  

You can create Intercom groups (groups of touch screens) and send a call to them. 

1 Select Communication in the Agents pane. Then in the Intercom Groups pane, 
click New. 

2 Name the Intercom group, and click Add. Example: “John’s Group.” 
3 Add the devices to the new group (see “Local Devices Tab” below). 

Local Devices tab 

Group properties: 

You can add devices to an existing group of 5" or 7" In-Wall Touch Screens, 7” In-Wall 
Touch Screen with Camera, 7” Portable Touch Screen with Camera, Door Station, or 
7” In-Wall, 10” In-Wall, and 7” Tabletop T3 Touch Screens. This lets the caller from one 
touch screen send out a call to the group of devices. 

To add or remove devices in a group: 

• Add: Select the device in the Local Devices tab, and then click Add. Click OK. 

- OR - 

Remove: Select the device in the right box of the Local Devices tab, and then 
click Remove. Click OK. 

Device Properties: 

To change device properties for the touch screens in the Intercom Group: 

1 Use the Local Devices tab to change the settings for all supported touch screens 
in the Intercom Group. 

• Manual Answer Timeout (seconds): Use the up or down arrow keys or 
enter how much time is allowed to answer an incoming call. 

• You can set the intercom device order by selecting the device and 
clicking the Move Down or Move Up buttons. 

2 Click Apply Changes when you're finished. 

External Devices tab 

The External Devices tab can be used to add external devices that can communicate 
with the intercom system, for example in an MDU solution. This functionality requires 
additional training and hardware not covered in this document. 

When to use the External Devices tab 

Use the External Devices tab when you have a SIP device shared across multiple 
Control4 systems that needs to register with SIP proxy on the controller. For example, 
a door entry system (lobby door station), shared SIP phone (lobby phone), or an IP 
Camera that can make SIP calls (lobby camera) 
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Note: A Communication server (or a PBX that the dealer has setup) is required for 
external devices. Adding the external devices into Composer enables the devices to be 
called from an Intercom session. 

Note: IP cameras that do not make a SIP call do not need to be added as external 
devices. Add them as an IP camera with a camera driver. 

To add or remove external devices: 

1 Click Add Device to add an external device to the intercom system. 
2 In the Add External Device Info window, add the new device info. 

• Caller Id: This is what will display when this device calls another intercom 
device. The Caller Id will display on the top bar of the intercom call 
screen. 

• SIP AOR: SIP address of record. Use this format: <userID>@<IP address of 
Communication server> e.g. 1234@192.168.1.10 

• Password: The password for this device  
• Use Alternate/Preview Camera: Check to enable an alternate or preview 

camera for the intercom device that will display in place of a camera built-
in to the device. 

• Camera Name: The camera name that will be displayed in Navigator  
• Is Doorstation: Check when the external device is a door station to enable 

the door station custom buttons in Navigator 
• Button1(2) Title: Name of the button to be displayed in Navigator 
• Button1(2) Command Type: Choose HTTP or DTMF 
• Button1(2) Command: Command to be sent when the button is pressed 
• Exclude from Navigator: Select this box to hide this device in Navigator. 

3 Highlight the device in the list and click Edit Device or Delete Device to edit the 
device info or delete the device from the external devices list. 

Programming with the Macro agent 
Use the Agents and Programming views to program this agent. Macros are routines 
that group several programming commands together. Examples: You can create and 
name a macro to use in several different programming events. The macro can be 
called from a particular program in the Programming Actions pane or you can create 
a Favorite on your touch screens or on-screen Navigator to call a Macro. 

You can create Macros: 

• To use in various programmed events 
• To use in Custom pages 
• To embed directly into the Navigators 
• To create shortcuts (Favorites) 

Prerequisites 

The following devices are added and identified (with a network address) in the 
project: 

• Controller 
• Light Switch 
• Navigator with a screen (touch screen, Control4 app, TV screen, etc.) 
• Any device involved in the triggering event (doorbell contact, Configurable 

Keypad, etc.) 
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To set up the Macros agent: 

1 Start Composer HE and connect to a Director. 
2 Click Agents. 
3 (First time only) Click Add to add the Macros agent to the project. 
4 Select Macros, and then click OK. 

To create a new Macro: 

5 Select Macros in the Agents pane, and click New. 
6 Name the new macro (for example, Bob), and then click Create. 

To add programming to the macro: 

In this example script, you will select the Family Room Switch which is on, and then 
turn off everything in the Living Room. 

7 Click the Programming view. 
8 In the Device Events pane, scroll down to Macros and select Bob. "When Bob is 

executed" appears in the Script pane. 
9 In the Device Actions pane, select Family Room and the Switch. 
10 Under Light, select On. 
11 Drag the green arrow ‘Turn on the Family > Switch' to the Script pane. 
12 Under Light, select Off. 
13 Drag the green arrow 'Turn off the Family > Switch' to the Script pane. 

 

14 You can add the macro to many programs that you create if you want to perform 
similar tasks, or you can program the macro for a specific device. For example, 
you can assign this macro to Button 1 on a Configurable Keypad to run the 
program when executed. 

Note: A unique macro cannot be edited or copied; only created or deleted. If you 
want to create a new macro based on another one, you must create a new one. 
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Programming with the Media Scenes agent 
Use the Media Scenes agent to allow simpler multi-zone audio control. Media Scenes 
link source, volume, and room-off commands. With Media Scenes, you can configure 
one or more rooms in a system to play the same music at the same volume. 

Example: A Media Scene for the entire house can include all the rooms in the Control4 
system. Another Media Scene can include only the Master Bedroom and Bath. You can 
create any number of Media Scenes for any number of rooms. 

Guidelines 

• To activate a Media Scene successfully (with the rooms being controlled 
simultaneously), activate the Media Scenes agent before starting any music 
playback. 

• Media scenes are persistent; when activated, a Media Scene remains active until 
deactivated or until the controller is powered down. If a Media Scene is 
deactivated while music is playing, the music continues to play in the associated 
rooms, but the rooms are no longer controlled in unison. Therefore, music can be 
stopped in one room while it continues to play in another room. 

• You can set up the Media Scene one time, and activate it when desired. Then play 
the music. 

To create a new Media Scene: 

1 Start Composer HE and connect to a Director. 
2 In the Agents pane, select Media Scenes, and click New. 
3 Enter a name for your new Media Scene. Example: Party Music. 
4 In the Agents pane, select Party Music, and then click Add Room in the Media 

Scenes pane. 

 

5 The dialog box lists the rooms in your system. Check the rooms where you want 
to play your Party Music, and then click OK. Example: Family, Kitchen, and 
Theater. 
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Tips: To remove a room from a scene, click Remove Room. To create another 
Media Scene, return to Step 1. 

 

Tip: You can add all rooms on a floor by clicking Main. This automatically selects 
all other rooms in that category. You can include also all rooms in your entire 
system in the Media Scene by clicking House. 

The rooms you selected appear in the new Media scene 'Party Music.' 

 

6 To activate the scene, click Activate Scene at the top of the screen. 

To deactivate the scene, click the Deactivate Scene button. 

7 You can program a button for your Media Scene. 
a In the Agents view, click Custom Buttons, and then below, click a room. In 

the Custom Buttons pane, click Add. 
b In the Add Screen dialog that appears, enter the name of the custom button, 

and then click OK. 
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Example: Click Theater and call the Screen name Media Scene. Name Button 
1: On/Off. 

The custom button name appears in the pane. 

8 Click the Programming view. 
9 In the Device Events pane scroll down, and click Custom Buttons. In the pane 

below, Custom Button Events, select the screen you want to program, and then 
select the Press radio button. 

Example: Select the screen Kitchen - Media Scene, and then select the Press 
radio button. 

10 In the Actions pane, select Kitchen. 
11 In the Theater Actions pane under Conditionals, press the Media Scene Active 

button, and then the True button. 
12 Drag the blue question mark to the Script pane. 
13 In the Actions pane, scroll down and select Media Scenes. 
14 In the Media Scenes Actions pane under Commands, press the Deactivate button, 

and then select Party Music. 
15 Drag the green arrow on top of the blue question mark in the Script pane. 
16 In the Actions pane, scroll up and select Kitchen. In the Kitchen Actions pane and 

in Conditionals, press the Media Scene Active button, and then the False button. 
17 Drag the blue question mark to the Script pane. 
18 In the Actions pane, scroll down and select Media Scenes. In the Media Scenes 

Actions pane and in Commands, press the Activate button, and then select Party 
Music. 

19 Drag the green arrow icon on top of the blue question mark in the Script pane. 

 

The Script pane now reads, 'When custom button ‘On/Off’ on screen ‘Media 
Scene’ in Kitchen is pressed...Activate scene ‘Party Music.' 

20 To execute the scene, click Execute. 
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21 Select the Press radio button. 

The event ‘When custom button ‘Toggle’ on screen ‘Garage Door’ in Family is 
pressed’ appears at the top of the Script pane. 

 

22 Under the Actions pane, highlight Garage Door. 
23 Click the Commands tab. 
24 Select the Toggle the Garage Door radio button. The action appears in the right 

middle pane. 
25 Click and drag the green arrow to the Script pane. 
26 From the File menu, select Refresh Navigators. 

Try the on-screen Navigator, Control4 app, or another Navigator to see the custom 
buttons you just created. 

Programming with the Scheduler agent 
Use the Agents and Programming views to create a Schedule . This agent lets you 
schedule time on the system to trigger events. You have the flexibility to program a 
specific one-time event, multiple events to re-occur daily, weekly, monthly, yearly, etc. 

Example: Schedule a fun event to wake up dad by playing his favorite song at 7:30 
AM on his birthday. 

88 



Composer HE 2.8.0 User Guide  Programming with agents 

Prerequisites 

Ensure that the devices to which you want to apply agents are added and identified in 
the system. Your dealer or installer can help you do this. 

To create a Schedule: 

1 Start Composer HE and connect to a Director. 
2 Click the Agents view. 

 

3 In the Agents pane, select Scheduler. The Scheduler interface panes appear. 

 

4 In the Scheduler pane, click New.  
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5 In the New Event dialog, enter the relevant information for this Scheduler 
instance: 
a Enter the Name Dad’s Birthday. 
b In Time: 

i Select the Time radio button. 
ii Highlight the hour: 07, minutes: 30, and AM. Use the drop-down list to 

select each time separately. 
c In Start Date, select one of the following: 

Select the Start radio button. Use the drop-down list to select today's date. 

Select Start on the radio button to choose an exact day, month, and year. Use 
the drop-down lists to make your selections. 

d Select Repeats: 

Select Yearly.  

Example: You want dad’s favorite song to play at 7:30 AM. This dialog lets you 
schedule one-time events and recurring events. 

Select Stop on, and use the drop-down list to select a month and year to stop 
this agent. 

e Click OK. The event is now added to the list of events. 
f To delete an event, select the event in the list, and click Delete. 

6 Click the Programming view.  
7 In the Device Events pane, select the Scheduler object at the bottom of the list. 
8 In Scheduler Events, click Dad’s Birthday event. The Script pane shows Dad's 

Birthday event. 

 

9 Choose the Device Actions to initiate in the Actions pane. 
10 Drag the actions to the Script pane. These scripted actions execute when Dad's 

Birthday event executes.  
11 You can use the Schedule in programming also to add conditionals or loops to 

your scripts.  
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Example: In the project tree (left pane), select the 3 Button Keypad.  

a In the Actions pane, scroll down and select the Scheduler agent. 
b Click the Conditionals tab, select Time, and Within 5 minutes before Sunset. 
c Drag the blue question mark to the Script pane. 
d In the project tree (right pane), select the light. 
e Click the Commands tab, select turn the room on, and drag the green arrow 

on top of the blue question mark in the Script pane.  

When you press the top button on the 3-Button Keypad, if it is within 5 (five) minutes 
before sunrise, the light comes on. The Scheduler agent lets you define one-time 
events and recurring events. 

Programming with the Screen Saver agent 
Use the Agents and Media view to set up and use the Screen Saver agent. 

Prerequisites 

• Ensure that the devices you will use to set up a screen saver and store your 
photos (for example, a network-attached storage or USB device) are attached to 
the primary controller. If you use a USB device, ensure that it is formatted to FAT 
32. 

To set up a Screen Saver: 

1 Start Composer HE and connect to a Director. 
2 Click Agents. 
3 In the Agents pane, select Screen Saver. 
4 Click New. 
5 From the drop-down menu, select the File Storage Location. 

 

6 Click the Media view.  
7 Click Screen Saver in the Media pane. 
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8 Click Add to scan and add new photos to the Screen Saver pane from the device 
you selected in the Network Storage Location box. 

 

9 To set up a custom screen saver on the Navigators, see the System User Guide. 

Programming with the Timer agent 
Use the Agents and Programming views to set up a timer. A Timer agent provides the 
ability to start a timer, stop a timer, or repeat a timer based on a given event and 
action. 

Example: A motion sensor in the system turns on a light when it detects motion, and 
then a timer is used to turn off the light after 15 minutes. Alternatively, a timer can be 
set to repeat an action whenever the timer expires, such as a Bathroom fan that 
restarts each time the light switch is turned on. 

Prerequisites 

• Ensure that the devices to which you want to apply the agents are added and 
configured in the system. Your dealer or installer can help you do this. 

This example uses the following devices in the project: 

• Controller 
• Any device involved in a triggering event (for example, a sensor for a motion 

detector) 

To set up a Timer: 

1 Start Composer HE and connect to a Director. 
2 Click the Agents view. 
3 In the Agents pane, select Timer.  
4 Click New. 
5 Type the name of the new Timer (for example, Bathroom Fan), and click Create. 
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6 In Interval, use the drop-down list to set the timer in seconds, minutes, or hours 
(hh:mm:ss), and then click OK. 

7 Click Start to start the timer. 
8 Click the Programming view. 
9 Highlight the Timer Action (in the Device Actions pane), and ensure the new 

Timer Actions display in the Commands tab (Start, Reset, and Stop in the lower 
right screen). 

 

10 Start, Restart, or Stop the timer as needed.  

The following table outlines how the timer behaves depending on the state of the 
timer when a command is executed. 

Command 
Executed is...  And Timer is ...  Then Event  Affect on 

Timer 

Start Running None  Restarts 

Reset  Stop and Start Restarts 

Stop  Stop  Stops 

Start  Not Running Start  Starts 

Reset  Start  Starts 

Stop  Stop  Stops 

Examples: 

• When you execute a Start command through programming on a running 
timer, no event is fired and the time is restarted. 

• When you execute a Start command through programming on a timer that is 
not running, the Start event is fired and the timer starts.  
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• When you execute a Reset command through programming on a running 
timer, the Stop and Start events are fired and the time is restarted. 

• When you execute a Reset command through programming on a timer that 
is not running, the Start event is fired and the time is restarted. 

11 Program to connect the timer to an event and action, and choose to Start, 
Restart, or Stop the timer. 
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Example screens 

See the example screens that follow. Notice how the timer is first used as an action, 
and then as an event. 

Event Screen: 
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Actions screen: 

 

Programming with the UI Configuration agent 
Use the UI Configuration agent to set wallpaper, custom wallpaper images, and screen 
saver settings on one or multiple T3 series touch screens in your project. 

To configure wallpaper with the UI Configuration agent: 

1 In the Agents view, select the UI Configuration agent, then click on the 
Wallpaper tab. 

2 Select from the default images listed, or click Add to add a custom image. 
Wallpaper images should be 1280 pixels wide by 800 pixels high (1280x800) for 
best results. Images with different resolutions may be scaled or trimmed to fit and 
may produce undesirable results. 

3 Click Apply To … to select the touch screens to be configured with the wallpaper. 

To configure screen saver settings with the UI Configuration agent: 

1 In the Agents view, select the UI Configuration agent, then click on the Screen 
Saver tab. 

2 Choose the screen saver mode. Available options include: 

• None 
• Blank 
• Date and Time 
• Current Media 
• Photos 
• Custom 
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3 Depending on your chosen screen saver mode, configure any additional options 
that appear. 

4 Configure the Begin After option. The value selected is the period of time the 
touch screen will wait after detecting inactivity until it turns on the screen saver. 

5 Click Apply To … to select the touch screens to be configured with the screen 
saver settings. 
 

Programming with the Variables agent 
Use the Agents view to set up variables. Ensure that the devices you want to use for 
variables are added and identified to the system.  

Variables provide other programming options not available using commands, 
conditionals, or loops. A variable is a representation of information about the 
controlled devices, for example, a power state or current level of the device. It works 
much like a Media Scenes agent. 

There are three types of variables you can use: 

• Room Variables—Provide you with additional programming options not available 
in the room object programming. Use Room object programming as a preference 
to room variables whenever possible. See “Using room variables.” 

• Custom Variables—Let you define additional programming options using: 
• Boolean—Provides a True/False option. For example, the light is on or off. If 

the light is on, it is True. If the light is off, it is False. 
• Device—Provides a list of device options. 
• Float—Provides a number value with a decimal. 
• Number—Provides a number value, for example, the light level is 70 percent. 
• String—Provides a text value, for example, the variable can be set to be 

equal to “cable box” .To program using a custom variable, in the Agent view 
select Variable and click New to set up a New Variable. 

Example: Use one keypad button to toggle between turning on the Theater 
Dimmer and the Theater Switch. 

Programming with the Wakeup agent 
Use the Agents and Programming views to program the Wakeup agent. The Wakeup 
agent lets you set wakeup times, lighting, music, and so on.  

Note: Wakeup times set in Composer HE synchronize with the Navigators or Control4 
apps. Likewise, wakeup times changed on the Navigators or Control4 apps will 
synchronize with Composer. 

Example: At a specified time in the Navigators, in the Bedroom start playing music 
from a CD and ramp up the light progressively from 10 to 70 percent light level in 15 
minutes. Thirty minutes before wakeup starts, set the temperature in the room to 72 
degrees. After 15 minutes of playing music, turn on the TV and play the Local News. 

Prerequisites 

1 Ensure that the devices to which you want to apply the agents are added and 
configured in the system. Your Control4 Dealer or Installer can help you do this. 

2 Ensure that you can play music in the project. 
3 Schedule a wakeup time. See “Programming with the Scheduler agent” for details. 
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This example uses the following devices in the project: 

• Controller 
• Digital Audio  
• Bedroom Dimmer 

To program using the Wakeup agent: 

1 Start Composer HE and connect to a Director. 
2 Click the Agents view. 
3 In the Agents pane, select Wakeup. The Wakeup panes appear. 
4 Click New.  
5 On the dialog that appears, enter a name. 

Example: Bedroom Wakeup 

6 Click OK. 

 

7 Enter Wakeup Scene 1 information. 
a Media—Click Choose Media. Checked by default. Use the drop-down list to 

select Albums, and then click a particular album and song you want to play 
when the Wakeup starts, for example, Norah Jones “Sunrise.” Set the desired 
volume using the scrollbar or the drop-down list. 

b Lights—Use the scrollbar or set the Light Level to 70, and use drop-down list 
to set the Ramp Rate to 15 minutes. 

c Temperature—Set the temperature to 72 degrees Fahrenheit to come on 30 
minutes before Wakeup starts. 
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8 Enter Wakeup Scene 2 information. 
a Scene 2—Check Wakeup Scene 2 and set the Start time to 15 minutes after 

Wakeup Scene 1. Set the desired volume for Wakeup Scene 2 using the 
scrollbar or drop-down list. 

b Media—Click Pick Media and use the drop-down list to select Broadcast 
Video. Highlight a local channel, (for example, 4-KTVX), and click OK. Set the 
Volume to 70. 

c Lights—De-select the box to make no changes for Wakeup Scene 2. 
d Temperature—De-select the box to make no changes for Wakeup Scene 2. 

 

9 Click the Programming view. 

Note: Your scene saves automatically, even when you leave the Agents view. 
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10 In the left pane, scroll down to view the available agents.  
11 Select the Scheduler agent event. 

The agent event appears at the top of the Script pane.  

 

12 In the Actions pane, scroll to the bottom to see the available agents.  
13 Highlight the Wakeup agent. The available commands appear. 

 

14 Under the Commands tab, do the following: 
a Highlight the Wakeup scene you want to use, for example, Bedroom 

Wakeup. 
b Highlight the location to play the scene, for example, Bedroom. 

15 Drag the green arrow to the Script pane. 
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16 When you finish, click Execute. 

Adding more devices 

To include an additional device to the Wakeup scene: 

1 In the project tree under Device Events, if you want to include additional devices 
in your Wakeup scene, scroll to the bottom of the project tree. 

2 Highlight the Wakeup agent. 
3 Highlight the Bedroom Wakeup. The Wakeup event appears at the top of the 

Script pane. 
4 Under the Actions pane, select the device for which you want to trigger the 

actions when the Wakeup event happens. Example: Select Bedside Lamp. 
5 Click the Commands tab. 
6 Select the Turn the Bedroom ->Bedside Lamp on command. The action appears 

in the right middle pane. 
7 Click and drag the green arrow to the Script pane. 
8 Click Execute to execute the command. 

Bedroom Wakeup example 

At the specified time in Navigators: 

1 Thirty minutes prior to wake-up time the temperature rises to 72 degrees. 
2 The album of choice starts playing at 6:45 AM. 
3 The lights start ramping up to 70 percent light level by 7:00 AM. 
4 The bedside lamp turns on. 
5 In 15 minutes, Wakeup Scene 2 begins.  
6 The TV turns on to the local news at 7:00 AM. The Wakeup is completed. 

Note: You can schedule the wakeup time from your Navigators. 

Related Composer HE tasks 
Use the Composer HE menu bar and views to perform the following sections. 

• “Using Back Up As for project configuration and media” 
• “Connecting to a Director” 
• “Exiting Composer HE” 
• “Getting controller project configuration” 
• “Loading the project configuration” 
• “Searching a topic” 
• “Controlling devices from the interface” 
• “Refreshing Navigators” 
• “Viewing the index” 
• “Register the controller” 
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Using ‘Back Up As’ for project configuration and 
media 

Use the Composer HE File menu to back up your project's configuration. When you 
start Composer HE and change your configuration or settings, Composer HE will ask 
you if you want to back up your project. You can back it up using a different file name 
if you'd like. 

To back up the file to a PC and save it as a different file name: 

1 From the File menu, select Back Up As. 

 

2 Type the new file name for your backup. Example: Noyce. 

 

3 When prompted, click Yes if you want to back up your media information. It's 
always good practice to do so. 
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Connecting to a Director 
Use the Composer HE menu bar to connect to a Director if you don't use the Startup 
screen to connect. 

To connect to a Director: 

1 Start Composer HE and connect to a Director. 
2 From the File menu, select Connect to Director. 
3 From the Directors dialog, choose the Director (the network address of the 

controller you are connecting to), and then click Connect. 

 

Exiting Composer HE 
Use the Composer HE menu bar or main menu to close and exit Composer HE. 

To exit Composer HE: 

1 From the Composer main menu, click Exit Composer. 

–OR- 

1 From the File menu, select Exit. The system will ask you if you want to back up 
your project. It is always good practice to do so. 
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Getting Controller Project Configuration 
Use the Composer HE startup screen or menu bar to access the latest controller 
configuration.  

To get the existing project configuration from a controller: 

1 Verify that your PC and the controller are connected to the same network. 
2 You can connect two ways: 

• From the Composer HE startup screen, click Director on Local Network. 

 

• From the File menu, select Connect to Director. 

 

When you connect to the controller's Director, if it exists, the project 
configuration appears in Composer. 
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Loading the project configuration 
Use the Composer HE startup screen or menu bar to load a project. 

Warning! Loading a project will cause the current project configuration to be 
replaced. To avoid losing your current project, back up your file first. 

Prerequisite 

• Verify that your PC and the controller are connected to the same network. 

To load the project configuration from a PC to the controller: 

1 Connect to the Director (you can do this two ways): 

• From the Composer HE startup screen, click Director on Local Network. 

 

• From the File menu, select Connect to Director. 

 

2 From the File menu, select Load Project. 
3 Click Yes when prompted to back up the project. 
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4 Choose another project file to open.  

Example: Noyce.c4p. When you see the new project displayed in the Monitoring 
view, the project is loaded to the controller, and you are connected. 

 

Searching a topic 
Use the Composer HE menu bar to search for a Help topic. Other topics may be 
available on the Control4 web site. 

To search for Help topics: 

1 Start Composer HE and connect to a Director. 
2 From the Help menu, select Contents. 
3 When the Help file opens, click the Search tab. 
4 In the keyword box, type the topic or keywords to locate the list of related topics, 

and then click List Topics. 
5 In Select Topic to display, click a topic from the list of links.  
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Tip: You can use the Index to search for keywords by clicking the Index tab. 

 

Controlling devices from the interface 
Use the Composer HE main menu to configure devices. 

Prerequisites 

Ensure that the device is added and configured in the project. Check with your dealer 
or installer to help you do that. 

To control a device: 

1 From the project tree or Devices pane, double-click the device. 
2 When the Device Control screen appears, use it to control the device from the 

software interface or to set parameters (for example, configuring LED lights on 
dimmers) temporarily. 
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Note: If you make changes in the Device Control screens for a device, it only changes 
the device settings temporarily. Use the Properties pane or Programming view to 
change the device settings permanently. 

Refreshing the Navigators 
Use the Composer HE menu bar to refresh your Navigators after you've made 
changes to your system. You refresh the Navigators when you change a setting in the 
system, attach a device, etc. 

To refresh the Navigators: 

1 Start Composer HE and connect to a Director. 
2 From the File menu, select Refresh Navigators. 

Tip: New media appears automatically in the Navigators unless you have a device 
that is disconnected or has changed locations. 

 

Viewing the index 
Use the Composer HE menu bar to view the Index. 

To access the Help index: 

1 Start Composer HE and connect to a Director. 
2 From the Help menu, select Index. 
3 View the list of available topics and keywords. 
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4 Double-click an entry to locate the topic, or select an entry and click Display. 

 

Register the controller  
Composer HE lets you register the controller to a customer account without having to 
log in to the customer’s account. You can now create a new account and register the 
controller in one step, register to an existing account found under your dealer of 
record, or manually register the controller using the 10-digit code from the customer’s 
account page under Controller registration. 

To set up a new customer.control4.com account and register this Control4 system 
(requires a dealer login): 

1 In Composer Pro, go to Tools > Account Services. 
2 Click the Add New Account tab to create a customer.control4.com account and 

start the registration process for the user. 
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3 Complete the Account Information form for the user, and then record the 
Account Name and Email Address for the user’s future reference. 

4 Click Add Account to create an account for this Control4 system and register the 
controller to the new account. 

  

To register the system to an existing customer account (requires a dealer login): 

1 In Composer Pro, go to Tools > Account Services. 
2 Click Select Account and select the existing account you wish to register to in 

the list of Customer Accounts. 

 

Note: If the existing customer account does not show up in the Customer Accounts 
list, have the customer log in to their account and verify their dealer of record is 
pointing to your dealer account. 

To manually register the system to an existing customer account: 

1 In Composer Pro, go to Tools > Account Services. 
2 Click Manual Registration. 
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3 From the customer.control4.com account page, copy the 10-digit registration 

code found under My Devices > Controller Registration > Register New Controller. 
This code is time sensitive and must be used within 10 minutes. It provides a 
temporary code used to exchange the security parameters and create a secure 
connection between customer.control4.com and the controller. 

4 On the Account Services page, click the text box and paste the 10-digit 
registration code in the box. 

5 Click the Register button on the Account Services page in Composer (now 
enabled) to complete the registration. The Current Status changes to 'Registered.' 
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Glossary 
4Sight: An Internet service that provides a connection 
to a home-automation system any time and from any 
place worldwide. 

A 

AAC: (Advanced Audio Coding)— A successor to the 
MP3 format. A standard, lossy compression and 
encoding scheme for digital audio. Touts better sound 
quality. 

action: An activity that occurs when an event prompts it 
to do so. 

agent: In Control4 programming, agents provide the 
ability to perform complex programming by using 
functional modules. There are various types of agents; 
for example, Advanced Lighting, Announcements, Email 
Notifications, Scheduler, and Wakeup. 

AV: Audio Video 

C 

CD: (Compact Disc)—An optical disc that stores digital 
data. This format is compatible with Control4 products. 

client: A software or hardware device that 
communicates to a server for feedback from the server 
via an application for the user. 

Command: A ‘do’ statement; actions the Director 
communicates to a device. 

Composer: The Control4 software used to design and 
define an automated system. 

Composer Pro: Composer is used to set up and 
configure Control4 devices to communicate with each 
other in a home automation system. 

conditional: An ‘if’ statement that asks true/false 
questions, which are acted upon in Composer 
programming. 

connection: Binding or linking devices together in 
Composer so they can communicate with each other. 

contact: Contacts are generally used to monitor the 
status of something (door, window, water sensor, etc.) 
and can be hooked up through a security panel or 
directly using a Control4 controller or Contact/Relay 
Extender. Contacts connected to a controller or 
Contact/Relay Extender can be configured either as NC 
(normally closed) or NO (normally open). 

Control4 system: An automated system designed and 
developed by Control4. 

controller: The main device that makes automation 
possible. There may be multiple controllers within a 
Control4 system. The controller that runs Director is 
referred to as the primary controller. 

D 

device: A component that requires a device driver; code 
that is used to allow the Control4 system to work with 
that device. 

device driver: Every device in the Control4 system 
needs a corresponding device driver to control the 
device. 

DHCP: (Dynamic Host Configuration Protocol)—A 
protocol used between a network client and a DHCP 
server (usually a router or access point) that dynamically 
assigns IP addresses from a pre-defined list to clients on 
a network. 

digital audio player: Provides digital audio streaming 
capabilities from a controller with hard disk space for 
music and movies. 

Director: Each Control4 controller (for example, an HC-
800 controller) ships with pre-installed Director 
software (Linux based) embedded in the device. The 
Director communicates with Control4 products and 
third-party products to enable the automation and 
interaction of individual devices. Director runs the 
Control4 devices. Composer Pro is the software used to 
connect to and program a system Director that resides 
on a controller. 

DriverWorks: The DriverWorks SDK is used to create 
two-way drivers for audio video (AV) and non-AV 
devices. 

DVD: (Digital Versatile Disc)— A media format for video 
and data storage. 

DVR: Digital Video Recorder. 

E 

end point: The final point (device) on the defined path 
over which audio and/or video content is routed to a 
room, for example, a TV or receiver. 

Ethernet: Uses Ethernet category 5 (CAT5, CAT5e, 
CAT6, etc.) wiring to transfer data. Ethernet uses a star 
network topology that allows multiple points to 
communicate to a single point. The Door Station and 
touch screens use Ethernet to communicate to the 
Control4 controller. 
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event: An action; used to trigger Composer 
programming when programming Control4 devices. 

F 

file format: A format used by applications to store/read 
files. 

FLAC: Supported by Control4 for software release 1.8 or 
later, this is a free, open source, lossless audio codec 
format that supports tagging, cover art and fast seeking. 
Audio is compressed with no loss in quality. 

G 

gateway: (router) Provides a means of communicating 
between two separate networks. 

H 

home network: A network installed in the customer’s 
home that provides an Ethernet or wireless connection 
so that Control4 devices can communicate with each 
other. 

home automation system: Example, the Control4 
system: a line of home-automation products that 
communicate with each other over Ethernet, WiFi, or 
ZigBee for a total home-automation experience. 

I 

intercom: A two-way audio and/or video 
communication method using Control4 devices. 

Interviewer Wizard: An automated setup program in 
Composer that builds a project for home automation. 

IR: A device controlled using a wireless remote control 
device. Commands are sent via pulses of infrared light to 
the device. 

L 

LCD: (Liquid Crystal Display)—A display used with some 
Control4 interfaces. 

LCD Navigator: An LCD device used to control lighting, 
music, videos, etc., on an LCD screen. 

LDAP: (Lightweight Directory Access Protocol)—Used 
in automated systems. 

LED: (Light Emitting Diode)—Primarily used in dimmers, 
switches, and keypads, but LEDs are also used on other 
Control4 devices for status purposes. 

Linux: An operating system used by several Control4 
devices. 

List Navigator: A System Remote Control device that 
uses a Navigator to list options to automate the home. 

live connection: A term used in Composer Pro to 
indicate an actual connection to the network. 

loop: A type of conditional in programming; a ‘while’ 
statement; for example, “while the sprinklers are on…” 

M 

media database: Media information is stored in the 
media database which lets users view their media from 
the Navigators. 

MP3/MP4: A music format that makes streaming audio 
available. 

N 

Navigator: A Control4 Navigator used with the Control4 
system to control lights, music, videos, etc. Navigator is 
software that the customer interacts with using a 
System Remote Control, on-screen Navigator, or touch 
screens. 

O 

On-Screen Device: Allows you to select the controller in 
the room that controls the source for the on-screen 
display. 

P 

playlist: A list of songs compiled in a list. The list can be 
compiled by songwriter, album, song type, or any 
combination. 

Power Over Ethernet: (POE)—Network cabling that 
provides Ethernet connectivity and device power over a 
single cable for Control4 devices. 

programming: A machine-readable artificial language 
used to express computations that can be performed by 
a device. 

project tree: A tree view in Composer where the project 
is layered by the larger branches (Home, Office, etc.) 
and then the lower branches (floor, rooms, etc.), and 
finally to the leaf level (drivers). 

R 

ramp rate: The rate that a dimmer ramps up its voltage. 

relay: An electrical switch that opens and closes. A relay 
is controlled by another electrical circuit. 

remote access: The ability to access a device from a 
remote location. 
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Remote Director: Connects you to the home network 
while working in Composer from a remote location. 

retrofit: The ability to set up a home-automation system 
in an existing structure or home. Compare this with new 
building construction. 

RJ-45 jack: An eight-pin jack used to connect CAT5e 
network cables to devices through Ethernet signals. 

router: See gateway. Functions similar to an AP but with 
additional functionality for controlling the network; for 
example, coordinating traffic between different 
networks. 

S 

serial-controlled device: Serial-controlled devices with 
an RS-232 interface and control protocol often have a 
higher level of controllability than IR-controlled devices. 
Examples of serial-controlled devices are projectors, 
multi-disc DVD changers, etc. 

switch: An extension of a router that adds more 
Ethernet ports to support additional devices or clients 
on the local network. 

system event: An action that causes another action; for 
example, if a projector turns on, it enables the other 
devices in the system that work with the projector. 

System Remote Control: A Control4 System Remote 
Control is a universal solution that replaces remote 
controls from other manufacturers and includes 
programmable buttons. This System Remote Control 
can access on-screen Navigators. 

T 

touch screen: A system Navigator that controls the 
home’s lighting, music, videos, and other devices in an 
automated system. 

U 

UI (user interface): The preferred term is Navigator. The 
Control4 interface used with Control4 devices to control 
a home or business, for example, touch screens, 
Control4 apps, or on-screen Navigators (TV screen). 

universal remote: Universal remote control. A third-
party remote control that can be programmed to 
replace other remotes in the home so that only one 
remote is needed, replacing all others. Control4 System 
Remote Control devices are a type of universal remote 
control. 

USB: (Universal Serial Bus)—A format used with USB 
sticks that plug in to a USB port on Control4 devices. 

V 

Virtual Connection: A term used in Composer Pro to 
indicate a connection outside the network. 

Virtual Director: A connection to a virtual controller 
only (a PC is the Director host rather than the 
controller). Projects created or edited here are benign 
until the saved project is loaded onto a controller. 

W 

WiFi: Uses bi-directional wireless technology to transfer 
data. WiFi (wireless fidelity) devices “connect” to each 
other by transmitting and receiving signals on a specific 
frequency of the radio band using a wireless access 
point. This technology uses the star network topology. 
WiFi uses high bandwidth 802.11. 

wired network: Uses Ethernet Category 5 or 6 (CAT5 or 
CAT6) wiring to send and receive data between devices 
connected to a network. 

wireless access point: A router extension with an 
antenna that communicates with WiFi devices and 
clients in the home. A wireless hub that connects to the 
wired network and distributes the wireless signal. 

wireless switch: Uses ZigBee; UL listed dimmer; single 
gang or multi-gang; has an air gap to cut power 
immediately if needed. 

WLAN: Wireless Local Area Network. 

WMA: (Windows Media Audio)—Audio data 
compression technology developed at Microsoft; an 
audio file format that competes with MP3. 

Z 

ZigBee: A wireless network that uses bi-directional 
wireless mesh network technology to transfer messages 
from one device to another. Unlike a star network 
topology where devices can only send messages to each 
other by sending them first to a single central device 
(which then delivers the message to the recipient 
device), a mesh network topology allows the devices to 
forward messages from one device to another, thereby 
extending the effective range of the network. Uses low 
bandwidth 802.15.4. Up to 250 devices are allowed per 
controller, but Control4 recommends 125 maximum. 

ZigBee Pro: The 1.1 version of ZigBee that provides 
improvements in standardization by: allowing more 
interoperability with other Control4 devices, support for 
home automation profiles, and improves the scalability 
of multiple ZigBee access points. 
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10-digit registration code, 108 
4Store agent, 50, 52 
AAC files, 10 
Access agent, 50 
Action, 25 
Actions pane, 42 
Actions, described, 26 
Add commands and conditionals, 

37 
Add DVDs, CDs, 10 
Add new variable, 43 
Advanced Lighting agent, 50 
Agent examples, 52 
Agent types, 50 
agent, custom agent variable 

Boolean, 35 
Agents, 5 
Agents view, 50 
agents, in programming, 27 
Agents, programming, 50 
Album tab, 22 
AM radio, 16 
Announcement agent, 50, 62 
Announcement example, 62 
Announcement, add text message, 

64 
Audio Video, Room Properties, 7 
Backup As, 99 
Backup system configuration, 99 
Basic programming, 26 
Blue question mark, 39 

programming, 31 
Boolean, 93 
Boolean values, 40 
Break command, in programming, 

29 
Cast and Synopsis tab, 25 
CD, add, 10 
Change localization options, 7 
Change Password, 9 
Change project date, time, 7 
Change project name, 7 
Change Project Properties, 8 
Change project settings, 7 
Change ZIP Code, 7 
Character set selection, 9 
Commands tab, 28 
Communication agent 

External Devices, 79 
program with, 77 

Composer 

register system, 106 
Composer HE, main view, 7 
Conditional loop, programming, 34 
Conditionals tab, 37 
Conditionals, in programming, 30 
Connect to Director, 101 
Contact Information, 2 
Container Variables, 51 
Copyright, 2 
Create an action, 42 
Create conditional, 42 
Create event, 42 
Custom agent variable agent 

string, 43 
Custom buttons, 50 
Custom Buttons agent, 50, 67 
Custom Buttons, in Navigators, 67 
Custom variables, 93 
Custom Variables, 51 
Date, 8 
Delay command, in programming, 

29 
Delete media, 10 
Device Actions, 87 
Device Control window, 104 
Device controls, 6 
Device Events pane, 42 
Device Properties, 8 
Device status, check, 8 
Devices, add to Wakeup Scene, 98 
Director on Local Network, 101 
Director, connect, 100 
Disc changer, 10 

and media setup, 10 
Disc changer, scan media, 10 
Disclaimer, 2 
DVD, add, 10 
Edit CD information, 22 
Edit DVD information, 24 
Edit media, 10 
Edit media information, 22 
EMail Notification agent, 50 
E-Mail Notification agent, 69 
Event, 25 
Events, described, 26 
Example, Actions pane, 93 
Example, Events pane, 92 
Example, program commands, 28 
Example, using conditionals, 30 
Examples, agents, 52 
Examples, events and actions, 25 

Exit Composer, 100 
External storage device, use, 19 
File extension, add, 13 
FLAC files, 10 
FM radio, 16 
GNU, 2 
Gracenote, 2 
Green arrow, 39 
Green arrow, and programming, 

29 
Intercom agent, 51 

program with, 74 
Internet radio 

setup, 17 
iTunes, 9 
Keypad releases, variable, 41 
Latitude, 8 
Legal notice, 2 
List view, 5 
Load Project, 102 
Locale, 9 
Longitude, 8 
Macro agent, 51 
Media, 5 
Media Auto-Scan, 13 
Media database, 10 
Media Managers, 9 
Media Monkey, 9 
Media scanning, status messages, 

13 
Media scene, 36 
Media Scenes agent, 51, 82 
Media view, 9 
Media, playlist setup, 9 
Media, remove, 14 
Media, scan, 9 
Media, setup, 9 
Monitor system status, 6 
Monitoring, 5 
Monitoring view, 5 
Movie tab, 24 
MP3, 9 
MPEG, 2 
Navigator, Room Properties, 7 
Navigators, and media selection, 9 
Navigators, refresh, 105 
Network share, 10 
Network-attached storage, 19 
New Event dialog, 87 
New variable agent, Boolean, 35 
New variable agent, number, 41 
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Online help, 103 
OS 2.3, 5 
Password, 7 
Playlist, create, 20 
Playlist, example set up, 44 
Programming and Communication 

agent, 77 
Programming and Intercom agent, 

74 
Programming commands, 28 
Programming in HE, 25 
Programming view, 5, 28 
Project name, 8 
Project properties, 7 
Project, backup, 99 
Properties pane, 5, 7 
Push Notification agent, 71 
Push Setting Control, 8 
Push Settings From Project, 8 
Radio stations, set up, 16 
Refresh Navigators, 105 
Related documents, 5 
Remove media, 14 
Rhapsody agent, 80 
Rhapsody playlist, 20 
Room object, 32 
Room Properties, 7 

room variables 
using, 32 

Room variables, 51, 93 
descriptions, 33 
in programming, 32 
setting up, 32 

Save As, project, 99 
Scan media, 9, 10 
Scan Now, 14 
Scanning 

Schedule, 13 
USB drive, 13 

Scheduler agent, 51, 85 
Scheduler agent, example, 27 
Scheduler pane, 86 
Screen Saver agent, 51, 88 
Script pane, 28 
Script pane, example, 31 
Script pane, programming, 26 
Script, defined, 26 
Search media titles, 10 
Search media, disc changer, 11 
Security, 9 
SIP, 77 
SNMP Configuration agent, 51 
Sony disc changer, auto-scan, 13 
SSL, 7, 9 

Start timer, 89 
Stop command, in programming, 

29 
Stop Scan, 14 
Stop timer, 89 
System security, 9 
Television, set up channels, 14 
Test media control, 18 
Text/image, edit, 64 
Time, 8 
Time zone, 8 
Timer agent, 51, 89 
Timer behavior, Timer agent, 90 
TuneIn, 18 
TV, set up channels, 14 
UHF/VHF, 14 
USB drive 

scan, 13 
USB drive, playing media, 19 
Variable, add new, 44 
variable, agent Boolean, 35 
Variables agent, 44, 51, 93 
Volume, add to announcement, 66 
Wakeup agent, 52, 94 
WAV file, add to announcement, 

65 
Windows Media Player, 9 
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